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Overview
PSRemote allows Canon PowerShot digital cameras to be operated tethered to a PC using a
USB cable. Virtually all of the camera's settings can be controlled from the PC (the degree of
control depends on the camera model). PSRemote is able to control the exposure mode, ISO,
shutter speed, aperture and lens zoom setting of most PowerShot cameras.
The USB cable may be up to 5m (16 feet) long. One or more USB hubs can be used to extend
the distance e.g. PSRemote has been tested using two 5m cables connected to USB hubs and a
4m cable connected to the camera giving a total length of 14m (approx 46 feet). There are
commercially available USB extenders which can be used if the camera needs to be further
from the computer. These can be active USB 2.0 extender cables or extenders using Cat 5e
cable for greater range and reliability. You can also use a USB hub that connects to a LAN
such as the Belkin Network USB Hub.
It is advisable to use a mains DC adaptor when using PSRemote for extended periods or when
using the time lapse features. If the camera is located a long way from the PC or is not easily
accessible it is essential that there is a way of turning the power to the camera on and off.
Then if there is a communication failure between the camera and PC it is possible to turn
everything off and to start again.

Photo Booth Mode

Please see the section on photo booth shooting for help one setting up a photo booth.

Supported Canon Cameras
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The following current Canon PowerShot cameras support remote capture and can be used
with PSRemote: Canon PowerShot SX100 IS, Canon PowerShot SX110 IS, Canon
PowerShot S5 IS, Canon PowerShot G9 and Canon PowerShot G10. Please note that neither
the G9 or the G10 support shooting in raw mode when connected to a PC.
Other recent cameras supporting remote capture include the Canon PowerShot A640, S80 and
S3 IS. Please see the Breeze Systems' website for the latest list of Canon PowerShot cameras
that support remote capture.

PSRemote Interface Library
PSRemote comes complete with a simple interface library and sample command line
program. This allows other programs to communicate with PSRemote and take pictures or
adjust the camera's settings. The interface library and sample command line application
(complete with VC++ .Net source code) can be found in the PSRemoteTest directory of the
PSRemote installation directory. Please see the readme.txt file for details of how to use the
interface library. Please see the section on running PSRemote from other apps for more
details.
[****]
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Installing and Registering PSRemote

Installing the software
The latest version of PSRemote can be downloaded from www.breezesys.com . If you are
upgrading your copy of PSRemote please uninstall the old version first and then install the
new version. You shouldn't need to re-enter your registration code, but it is a good idea to
keep a copy just in case.
To install PSRemote simply run the setup program and follow the on-screen instructions.
PSRemote can be uninstalled using the standard Windows "Add/Remove Programs" dialog
available from "Control Panel".
PSRemote runs on Windows 8.1, Windows 8, Windows 7 and Windows Vista.
Windows XP: Microsoft ended support for Windows XP on April 8, 2014 and therefore we
are no longer able test or support our software on Windows XP. PSRemote should still work
on Windows XP however we strongly recommend that you upgrade to a more recent version
of Windows.

Registering the software
© 2016 Breeze Systems Ltd

Installing and Registering PSRemote

5

Unregistered copies of PSRemote will not save images to disk or to the camera's memory
card. To purchase a licence for PSRemote please visit our website: http://www.breezesys.
com/PSRemote. You will be sent an email containing your registration details when your
payment has been received.
To register PSRemote click on the "Help" menu and select "Register..." from the menu and
the dialog below will be displayed:

Then enter your registration name and code exactly as they appear in your registration email.
You may find it easier to cut and paste the registration code directly from your registration
email to avoid mistakes when entering it. The registration code is made up of four groups of
eight characters separated by hyphens (-). Each group of eight characters should only contain
the digits 0 to 9 and the letters A to F.
[****]
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Main Window

The Main Window
The main window shows the main camera controls together with a large preview display and
a histogram for assessing exposure. The main camera settings can be changed using the
controls down the left hand side of the main window. Other settings are available from the
menus.

© 2016 Breeze Systems Ltd
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Connecting to the camera
When you run PSRemote it attempts to connect to the camera. The first time it connects to a
new camera model it needs to learn the camera's settings and this can take a while (30 secs or
more depending on the camera model). The settings are stored and connecting the next time
will be much faster.
You can manually connect and disconnect from the camera by selecting the appropriate entry
from the "Camera" menu. If more than one camera is connected to the PC when PSRemote is
run a selection dialog will be displayed listing the available cameras.
When the "Auto reconnect" option is selected in the Camera menu and no camera is currently
connected PSRemote will attempt to connect to the camera every 6 secs until it connects to a
camera. In fullscreen photobooth mode auto reconnect will automatically restart the
photobooth mode, enable the live view if required and display the "ready" screen when the
camera is connected.
Most versions of Windows display a dialog with a list of available applications when a
camera is connected via USB. PSRemote can be added to this list by selecting "Register for
camera events" from the "Camera" menu.

Release Button
© 2016 Breeze Systems Ltd
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Click on the Release button (or press F8) to take a picture. The picture is automatically
downloaded to the PC, displayed in the main window and saved to disk. Images can be stored
on the PC's hard disk, on the camera's memory card or both.
The camera's shutter release can also be used to take pictures. The shutter release is the only
camera control which is enabled when the camera is in remote mode. All other camera
settings have to be set from PSRemote on the PC.

Preview Button
Click on the Preview button (or press F9) to take a picture in preview mode. The picture is
taken as a small JPEG with normal quality so that it is downloaded to the PC quickly. The
picture is not stored on the PC's disk or the camera's CF card. The size of the preview image
can be specified in preferences.

Auto Bracketing
PSRemote has flexible settings for auto bracketing (taking a sequence of shots using different
exposure settings) which simplify the taking of shots which are later combined together to
form a single HDR (high dynamic range) image. To enable auto bracketing select the "Autobracket" checkbox and then click on the "Settings..." button to display the auto bracket
settings dialog below:

You can set the number of shots in the sequence using the first dropdown list. Then set the
number of exposure stops should separate each shot. This can be set to 1/3, 2/3, 1, 1 1/3, 1 2/3
or 2 stop per shot.

© 2016 Breeze Systems Ltd
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The different exposures are set using the camera's exposure compensation control if the one of
the auto exposure modes is selected. If manual exposure mode is selected the exposure will be
varied using either the shutter speed or the aperture according to the settings in this dialog.
Please note that PowerShot cameras have a limited range of apertures and so it may not be
possible to take the complete sequence by varying the aperture.
PSRemote can optionally run a command at the end of the auto bracket sequence to combine
the shots. To do this click on the "Execute command at end of auto bracket sequence"
checkbox and enter the name of the program or script to run. In the screenshot above the
script "photomatix.bat" has been entered. This will run the Windows batch file
"photomatix.bat" which combines the images using Photomatix Pro (which can be purchased
from http://www.hdrsoft.com) and displays the result in BreezeBrowser Pro (
http://www.breezesys.com/BreezeBrowser ). The batch file can be found in the PSRemote
installation folder (usually C:\Program Files\BreezeSys\PSRemote) and makes use of the
command line interface for Photomatix Pro. Please see the batch file for details.
Suggested procedure for auto bracketing:
1. Use a tripod and compose the shot as required
2. Switch to manual exposure mode and low ISO setting to maximize the quality
3. Set the required aperture (e.g. use a small aperture like f/16 for good depth of field)
4. Take a preview shot to determine the correct exposure (this can be judged by looking at
the histogram display). It may be necessary to take a number of test shots to get the
correct exposure. Adjust the exposure by changing the shutter speed
5. Use AF lock to set the focus so that it doesn't change between shots
6. Set the required number of shots and number of stops separating each shot (a 5 shot
sequence with 1 stop increments is a good start, more shots may be required if the
brightness range in the shot is very large)
7. Press the "Release" button and PSRemote will automatically take the sequence

Zooming the Lens
Use the slider control beneath the release and preview buttons to zoom the camera's lens. The
zoom range and current focal length of the lens is displayed above the zoom control. Some
cameras allow the use of digital zoom and this is displayed in red when it is used.

Deleting Images
Press the Delete key to delete the current picture. If the picture was saved to disk it is deleted
from the disk and removed from the display.
Note: Pictures saved to the CF card are not deleted.

Changing Camera Settings
The camera settings can only be changed using the controls in the main window or directly
© 2016 Breeze Systems Ltd
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using the camera's controls. Not all controls can be changed in all camera modes (e.g. the
shutter speed can only be set in Manual and Tv exposure modes) and so some controls are
"grayed out" when they are not applicable or are not supported by that camera model.

Bulb Mode
Bulb mode is not available when the camera is operating in remote mode. This is a limitation
of the camera not PSRemote.

AF Lock
Manual control of focus is not available when the camera is in remote mode, but some recent
camera models allow the use of AF lock. When AF lock is selected the camera will focus
using normal auto-focus and then lock the focus setting. This allows several pictures to be
taken using the same focus setting.
Note: Zooming the lens or changing the auto-focus distance setting will release the AF lock.

Live Viewfinder Display
All PowerShot camera models since 2002 that support remote capture allow live display of
the viewfinder data on a window on the PC. The live viewfinder display can be enabled by
selecting "Live Viewfinder" from the "Camera" window. There are also options for displaying
the viewfinder data on the camera's LCD display or sending it to the video out connection.
The grid overlay, if selected, will also be displayed in the live viewfinder window.

© 2016 Breeze Systems Ltd
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Select the "Stay on top" checkbox to make the live viewfinder window a topmost window
which is always visible (the main window controls can still be accessed when the live
viewfinder window is displayed).
Select the "Onion skinning" checkbox to enable onion skinning. Onion skinning displays the
current live viewfinder data superimposed on the last image taken. This is a useful technique
when taking pictures for animation because it allows you to compare the current image with
the previous frame. When a picture is taken (not a preview image) the image for the previous
frame is updated. It can also be updated by pressing the F5 function key.
Select the "Crop" checkbox to crop a portion of the image and the areas to be cropped out of
the image will be grayed out as in the screenshot above. The cropped area can be adjusted
using the mouse by moving it to one of the edges, pressing the left button and dragging the
edge to the required position. The cropped area can also be moved by pressing the left mouse
button when the pointer is inside the area and dragging it to the required position. When the
picture is taken only the highlighted region will be saved. Preview images will display the
whole image with the cropped area highlighted similar to the live viewfinder display.
Please note: The crop area can only be adjusted when the live viewfinder scaling is set to 1x
and cropping can only be applied to JPEG images. It isn't possible to crop images when
shooting in raw format.
Live viewfinder display was first introduced with the G2 in 2001. Older models (e.g. the G1
and Pro90IS) and basic models from 2001/2002 (e.g. A40) do not support live viewfinder
display on the PC.

Image Orientation
The image orientation can be set using the "View" menu. Some recent cameras have an
orientation sensor which detects the camera's orientation and sets the image's orientation
accordingly. Select "Use Orientation Sensor" from the "View" menu to use this feature when
downloading images to PSRemote and displaying them in the live viewfinder window.
Select "Auto-Rotate" to losslessly rotate JPEG images according to the EXIF orientation
value when saving them to the PC. This is useful if the images are going to used by
applications which are unable to read the EXIF orientation from the shooting data.
Please note: this option has no effect on images stored on the camera's memory card

Reviewing Previous Images
You may review previous shots by pressing the "<- Prev Image" and "Next Image ->" buttons
or by using the left and right cursor keys. The main and preview images displays are updated
to display the selected image together with the histogram display. You can delete previously
taken shots in the normal way. To help identify which shot is being displayed the status bar
shows the filename of the image and its number in the sequence e.g. [3 of 5].
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When a picture is taken the display is updated to show the new shot.

Grid Display
To toggle the grid overlay on the preview image type Ctrl+G or select "Display Grid" from
the "View" menu. Select "Grid Settings..." from the "View" menu to display the "Grid
Settings" dialog, shown below:

NOTE: The grid display is only displayed on the preview image and doesn't affect images
saved to disk.

Blanking the Screen
To avoid extraneous light from the computer display affecting the lighting setup the screen
can be blanked when taking a photo. To do this click on the "Camera" menu and select "Blank
screen when taking photo". When this option is selected the screen will be automatically
blanked when the shutter is released either from the camera or the PC. The screen will be
restored after the camera has finished taking the picture. The screen may also be restored by
clicking the left mouse button.

Adding Comments
Comments can be automatically added to images as they are taken by entering the comment
text in the edit box located above the histogram.

Editing Images and Editor Setup
Right click on the image and select "Edit Image" to open the image in an image editor (or
press F3). For this feature to work you need to tell PSRemote how to run the image editor by
selecting "Setup Image Editor" from the File menu.

© 2016 Breeze Systems Ltd
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Select the "Use the Windows Explorer 'Open' command" option to use the same editor or
viewer as when you open or double-click an image in Windows Explorer.
Select the other option and enter the command line in the edit box to specify a different editor.
Select "Automatically edit image when a photo is taken" to automatically load images into an
editor when they are taken. Please take care not to load too many images into your editor as
Windows may run low on memory causing the editor or PSRemote to fail.
NOTES:
1. Only images saved to disk can be edited. Preview images cannot be edited.
2. Most image editors cannot open Canon raw files directly and will display an error
message if you try to edit a raw image.

The Image Preview Window
To display an enlarged preview window select View Image from the Image menu (or press
F7). The image preview window can be left on the screen while more pictures are taken to
monitor composition or focus in critical areas e.g. the eyes of a model during a portrait
session. The preview window is automatically updated when the image in the main window
changes.
The image can be scrolled by moving the scroll bars or by clicking the left button on the
mouse and dragging the image. If the image preview window is still displayed when a picture
is taken it will be updated to show the same area of the new shot. This is very useful for
monitoring important areas of the image e.g. a model's eyes when taking portraits.
To avoid a lengthy delay converting raw images the embedded JPEG is displayed when
pictures are taken in raw mode. This JPEG is only 640x480 pixels in size.

Flashing Highlight Display
Select "Flashing Highlights" from the "View" menu to display over-exposed areas by
© 2016 Breeze Systems Ltd
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highlighting them flashing on and off in black. The method of calculating the highlight values
and the threshold at which to start flashing them can be specified by selecting "Highlight
Settings..." from the "View" menu.
[****]

4

Time Lapse
Select "Time-lapse..." from the "Camera" menu to take time-lapse shots.
The time lapse sequence can be set to start immediately or to start at a particular time and
date. You can either specify an end time and date for the time lapse sequence or the number of
frames in the sequence.
You can specify the interval between shots.
Note: If you set the interval to a time shorter than that required to take and download the
picture the sequence will run as fast as possible.
Press the "Start" button to start the time lapse sequence.

WARNING: Canon PowerShot cameras are not designed to be operated for long periods of
time. Running the camera continuously for several days or weeks may result in permanent
damage to your camera. Breeze Systems cannot accept any responsibility for any damage
caused to cameras.

5

Post Processing (taking photos for web display)
PSRemote can automatically resize, level and sharpen JPEG images after they are taken making it

© 2016 Breeze Systems Ltd
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quick and simple to prepare images for online auctions and web sites. This option can only be applied
to JPEG images which are saved to computer's disk. To enable post processing select "Post
processing..." from the File menu and the dialog below will be displayed:

Resizing
The standard resolution of the camera is much bigger than is needed for web display. Most computer
displays are 800 x 600 pixels or larger and so it is a good idea to resize the images to around 450
pixels wide or high.
Auto levels
Auto levels automatically adjusts the contrast of the image so that the range of tones goes from black
through to white. This option is useful for automatically adjusting for exposure errors (image too dark
or too bright). The black point sets the percentage of the pixels in the image that are set to black and
the white point sets the percentage of pixels of pixels that are set to white. A value of 0.05% is a good
starting point for both settings. If the black point is set too high some of the detail in the dark areas of
the photo will be lost. Likewise setting the white point too high will lose detail in the bright areas.
Sharpening
Digital images usually need some sharpening after they have been resized. A sharpening amount of
between 75 and 85 usually gives good results. Setting this value too high will result in very harsh edges
in the image.
JPEG save quality
JPEG images use "lossy" compression to reduce the size of the file saved on your hard disk or
downloaded from a website. This lossy compression throws away some of the image data to reduce
the file size. Lower values give smaller file sizes but reduce the quality of the image. If the quality is too
low you will start to see halos and blurring around the edges in the image. A save quality of between
70 and 90 generally gives good results.
Defaults
Press the "Defaults" button to set the values to suggested values for images for an online auction site
or a website.

© 2016 Breeze Systems Ltd
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Running PSRemote from other apps

Overview
PSRemote includes an interface library called PSRemoteLib.dll which can be used by other
applications to control PSRemote. Also included is a simple command line application called
PSRemoteTest.exe which can be used to control PSRemote from a command prompt or a
batch file. For example a batch file could be written to take a series of photos using different
apertures and shutter speeds to bracket the exposure.

PSRemoteLib.dll
PSRemoteLib.dll is a library that can be used by other programs to control PSRemote. It can
be found in the PSRemoteTest folder where PSRemote is installed (usually C:\Program
Files\BreezeSys\PSRemote\PSRemoteTest). Please see the ReadMe.txt and PSRemoteLib.h
files for details.
Files included in the PSRemoteTest directory:
PSRemoteTest.exe - compiled console application
interval_shooting.pl - example Perl script for time-lapse sequences
PSRemoteLib.dll - DLL used by PSRemoteTest.exe to interface with PSRemote
PSRemoteLib.lib - lib for C++ apps to link to the DLL
PSRemoteLib.h - header file for C++ applications using the DLL
Source - directory containing a VC++ project and source code for PSRemoteTest.exe

PSRemoteTest.exe
PSRemoteTest.exe is a simple command line application that communicates with PSRemote
and allows the shutter to be released and some of the camera settings to be changed.
PSRemoteTest.exe and complete source code to build it using Visual C++ .Net can be found
in the PSRemoteTest folder where PSRemote is installed (usually C:\Program
Files\BreezeSys\PSRemote).
To run PSRemoteTest.exe first run PSRemote and then open a command prompt window and
change directory to the PSRemoteTest folder. Then run PSRemoteTest.exe -h to get a list of
the available commands.
Here is the output from a simple session where the output directory is set and the shutter is
released (commands typed in by the user are shown in bold):
Microsoft Windows XP [Version 5.1.2600]
(C) Copyright 1985-2001 Microsoft Corp.

© 2016 Breeze Systems Ltd
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C:\>cd C:\Program Files\BreezeSys\PSRemote\PSRemoteTest
C:\Program Files\BreezeSys\PSRemote\PSRemoteTest>PSRemoteTest.exe -h
Usage: PSRemoteTest [-w [<shots>] [-i <interval>]] [-a <aperture>] [-s <shutter>]

-h
-w <shots>

-t <interval>

print this usage information
run camera as a webcam for <shots> shots
images are saved as webcam.jpg in the current
directory
specify the number of seconds between shots
when
used as a webcam

-a <aperture>

set the aperture, 0 = widest aperture

-s <shutter>

set the shutter speed, 0 = longest shutter speed

-e <mode>

set the exposure mode (EOS-1D and EOS-1DS
only)

-x <comp>

set the exposure compensation

-i <quality>

set the image size and quality

-I <ISO>

set the ISO

-c <comment>

set comment to be added to images (max 255
chars)

-o <directory>

set the output directory

-q

query output directory

-n

don't release shutter

C:\Program Files\BreezeSys\PSRemote\PSRemoteTest>PSRemoteTest.exe -n -o C:\Photos -q
Output directory: C:\Photos\2004-01-15\
C:\Program Files\BreezeSys\PSRemote\PSRemoteTest>PSRemoteTest.exe
Success, image saved as: C:\Photos\2004-01-15\IMG_0001.JPG
C:\Program Files\BreezeSys\PSRemote\PSRemoteTest>

Sample Perl script for time-lapse sequences
interval_shooting.pl is a sample Perl script which can be used to take time-lapse sequences. It
connects to the camera, takes a photo and then disconnects from the camera until it is time to
take the next photo. The script can be configured to take shots at different intervals with a
specified start time and stop time and can take a single shot or take a three shot auto-

7

Motion Detection

Overview
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The live viewfinder display can be used to feed images to motion detection software which
instructs the camera to take a photograph when motion is detected. Applications include
security monitoring and wildlife photography.
The Webcam Zone Trigger motion detection software was developed by a company called
Omega Unfold and can be purchased from their website.
Please note: This release of PSRemote requires "Webcam Zone Trigger for Breeze Systems"
version 1.8 or later.

Setup and Operation
Connect the camera to your PC and run PSRemote. When PSRemote is running and
connected to your camera select "Motion detection..." from the Camera menu. Next run
Webcam Zone Trigger and select "Connect to Breeze Systems PSRemote software". You
should see the live viewfinder display from the camera in the Webcam Zone Trigger window.
Now select "Add Trigger" and a circle showing the area being monitored will appear in the
viewfinder window. Use the mouse to drag the circle to the area you wish to monitor. When
motion is detected the circle will turn blue and a picture will be taken. It make take a few
seconds for the camera to take the picture.
All recent Canon PowerShot cameras that support remote capture operation can display live
viewfinder images using PSRemote which can be used for motion detection. Please see the
Breeze Systems' website for the latest list of Canon PowerShot cameras that support remote
capture.

Hints and tips
1. Mount the camera firmly (e.g. on a sturdy tripod) to avoid the camera moving and
causing pictures to be taken
2. Use an external power supply for the camera as it can only run for two or three hours on
one set of batteries
3. Use the AF lock option in PSRemote to reduce the delay in taking a picture when
motion is detected
4. Use the AF lock option in PSRemote to prefocus the camera on the area of interest e.g.
if you are taking photos of birds at a bird feeder turn the camera and prefocus on the
bird feeder then move the camera so that the feeder is on the edge of the shot
5. Make sure there is sufficient of free space on your hard disk to store any photos that are
taken
6. Take a few test shots to check the camera exposure. If necessary use exposure
compensation to adjust the exposure for the best results.
7. Monitor the photos and setup regularly to check for problems like exhausted camera
batteries, out of focus images, incorrect exposure or loss of connection between the
camera and the PC.
8. Use a low ISO setting for maximum image quality and set the aperture to f/8 to
maximize the depth of field (the range of range of distances that are in focus). Take a
test photo and check the shutter speed is fast enough to freeze any motion in the
© 2016 Breeze Systems Ltd
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subject. If the shutter speed is not fast enough you will need to set a higher ISO setting
or larger aperture (smaller Av number e.g. f/4).
WARNING: Canon PowerShot cameras are not designed to be operated for long periods of
time. Running the camera continuously for several days or weeks may result in permanent
damage to your camera. Breeze Systems cannot accept any responsibility for any damage
caused to cameras.

8

Color Management
PSRemote supports the color management of images displayed in the main window and when printing
photo booth images. Color management helps produce more accurate and consistent colors when
displaying and printing images. PSRemote uses the perceptual rendering intent for both the display
and printing of images. A detailed explanation of color management is beyond the scope of this help
file.
Select "Color management settings..." from the File menu in the main window to display the color
management settings dialog:

Color Management of displayed images
Select a suitable color profile for your monitor by clicking on the "..." browse button or clicking on the
"Use default monitor profile" button. Next select a suitable color profile for your camera. Normally this
will be the sRGB Color Space profile unless your camera is set to AdobeRGB in which case it should
be the AdobeRGB 1998 profile. Then select "Enable color management of displayed images" to
enable color management.
Please note: For performance reasons color management is only applied to images displayed in the
main and full screen windows. It is not applied to live images or images displayed in photo booth
mode.
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Color Management of printed images
First select a suitable color profile for your camera as described above. Next select a suitable color
profile for your printer by clicking on the "..." browse button. Most printer manufacturers provide generic
color profiles for their printers, often with different profiles for different papers. Then select "Enable
color management of printed images" checkbox to color manage the printing of photos for more
accurate colors.
IMPORTANT: Please disable color management in the printer driver when selecting color
management in PSRemote otherwise the colors may be adjusted twice.

9

Photobooth Shooting

Start here
The quickest way to get started is to setup your printer and then use the photobooth setup wizard to
set everything else up for you.
You can then change the appearance of the screens by editing the JPEG screen images in an image
editor such as Photoshop or Photoshop Elements.
Then use the print layout editor to edit the print layout or to load a different preset print layout.
The advanced settings can be used to fine tune the settings.
A series of shortcut buttons to provide quick access to key photobooth options can be displayed at the
top of the main window:

The photobooth shortcut buttons can be turned on or off by selecting "Photobooth Shortcuts" from the
View menu.

© 2016 Breeze Systems Ltd
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More detailed help...
Topics covered in this section:
Photobooth setup wizard
Editing the print layout
Touchscreen settings
Saving settings for future reference and using profiles
Print layout
Custom layout
Other output options
Images displayed to the user
Running external commands
Touchscreen keyboard
Keyboard shortcuts
Using external buttons for photobooth shooting
In operation
Reprinting photos after an event
Green screen shooting
How to create PNG images using Photoshop and Photoshop Elements
Uploading to social networking and photo sharing sites
Please also see the series of articles on photobooth shooting on our website.

9.1

Photobooth Setup Wizard
The photobooth setup wizard provides a fast and simple way of creating the screens and the print
layout for common photobooth configurations.

Before you start
Before running the setup wizard please ensure that your printer is setup correctly. The photo booth
software uses the Windows default printer and page settings. These can be setup by selecting
"Devices and Printers" from the Windows Start menu. Right click on the printer you wish to use and
check that "Set as default printer" is selected. Then select "Printing preferences" and setup the layout,
paper and quality settings ready for for photo booth printing.
Then select "Photobooth Setup Wizard..." from the File menu to start the setup wizard.

Step 1: Printer Settings
This step displays the current printer settings and asks you to select a print layout. The settings for a
DNP DS-40 printer loaded with 6x4 paper are shown below:

© 2016 Breeze Systems Ltd
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First check the printer settings and click on the "Setup printer..." button if they need changing.
Please note: if you printing a double strip of 3 or double strip of 4 photos and are using a dyesub
printer which can cut a 4"x6" sheet into two 2"x6" strips you need to select this option in the printer
driver by clicking on the "Setup printer..." button.
Next select one of the seven print layout options:
"Classic double strip of 4 photos" - This prints two columns of four images side by side as shown
below:
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"Single strip of 4 photos" - This prints a single column of four images as shown below. This option is
useful for printers like the Sony UP-DR200 which can cut 6x2 strips from 6x4 paper and treat these as
6x2 pages.
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"Double strip of 3 photos" - Similar to the "Classic double strip of 4 photos" but with only three photos
and more space for logos etc.
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"Single strip of 3 photos" - Similar to the "Single strip of 4 photos" but with only three photos and more
space for logos etc.
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"1 large photo with 3 smaller ones below" - This layout gives plenty of space for logos and captions as
shown below:
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"2 rows of 2 photos" - This option fills the page with four equally sized photos arranged in a 2 x 2 grid:

"Single photo" - This option fills the page with a single photo:
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When you have selected your preferred layout press the "Next >" button to go to step 2.

Step 2: Specify the photo booth images folder
This step allows you to specify the name of the folder where the various screen and layout images
should be stored and looks like this:

Enter the name of the photo booth images folder. The screens for the photo booth and the optional
layout images will be saved in this folder and can be edited later using an image editor to personalize
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the look of your booth.
Press the "Next >" button to go to step 3.

Step 3: Specify user interface options
This step allows you to specify the options available to users of your photo booth and looks like this:

Select the options you wish to use and then press the "Finish" button to create the photo booth
settings. The settings are saved to a file named settings.xml in the photobooth images folder. These
settings can be loaded again by pressing the "Load..." in the photobooth settings dialog.
"DSLR template compatibility mode (3:2 aspect ratio)" - select this option if you want the print layouts
to be compatible with templates from our DSLR based photobooth software (DSLR Remote Pro for
Windows and NKRemote). Normally photos from a PowerShot camera aren't as wide as photos from a
DSLR camera. Selecting this option will crop a small portion from the top and bottom of each photo so
that it matches the aspect ratio of photos from a DSLR camera. Please see this section for more
information.
"Use touchscreen" - select this option if your booth has a touchscreen. The setup wizard will
automatically add buttons and touchscreen actions to the screens shown to users.
"Allow users to select BW or color prints" - If the "Use touchscreen" option is selected this option will
add buttons and touchscreen actions to allow users to choose color or B&W prints. If "Use
touchscreen" is not selected this option will do nothing but users will be able to select B&W or color
using the keyboard shortcuts Ctrl+B and Ctrl+C.
"Preview each photo after it is taken" - when this option is selected a full screen preview will be
displayed for 3 secs after each shot is taken.
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"Display thumbnails of the photos taken so far" - select this option to display a small thumbnail of each
shot taken so far down the right hand of the screen. Each screen will have a series of small gray
rectangles added to show where the thumbnails will be placed. Please see the section on the optional
thumbnail display for more information.
"Display print preview and ask for confirmation before printing" - when this option is selected a full
screen preview of the print layout will be displayed before printing. If the "Use touchscreen" option is
selected buttons and touchscreen actions allowing users to print or reject the photos will be added. If
the "Use touchscreen" option is not selected users need to press A to accept the print or X to reject it.
"Add print option in sharing screen" - select this option to allow users to print photos from the sharing
screen.
"Facebook upload" - select this option to allow users to upload photos to their personal Facebook page
direct from the photo booth (requires an internet connection). Please see the section on uploading
photos to social networks for more information on uploading photos to Facebook.
"Twitter tweet" - select this option to allow users to post photos their personal Twitter feed direct from
the photo booth (requires an internet connection). Please see the section on uploading photos to social
networks for more information on posting photos to Twitter.
"MMS/SMS" - select this option to allow users to text photos to their cellphone via MMS or SMS
(requires an internet connection and an account with Twilio.com). Please see the section on uploading
photos to social networks for more information texting photos.
"Email photos" - select this option to allow users to email photos direct from the photo booth (requires
an internet connection). Please see the section on uploading photos to social networks for more
information on emailing photos.
"Add a background.jpg image which can be edited to add logos etc." - select this option if you want to
add logos etc. to the prints. This will create a background.jpg image the same size in pixels as the
printed output and place it the photo booth images folder. Please edit the background.jpg to add logos
etc.
The inactivity timeout can be set to switch the booth to standby mode and display the welcome.jpg
screen after a preset number of seconds if there is no user input. Set this to 0 to disable the inactivity
timeout. The booth can be switched back to the ready screen by pressing F6 or touching the screen (if
available).

What happens next?
Please try running the booth and taking a set of photos to check the print layout. If the photos aren't
correctly centered on the page or the gaps between the photos is too large you can adjust the settings
by clicking on the "Print Layout" shortcut button (or by selecting File->Photobooth settings... and
clicking on the "Settings..." button to the right of the "Custom layout" checkbox. Please see the section
on the print layout editor for more details.
Logos and other graphics can be added to the prints by creating a background.jpg image and editing
this in an image editor. The background.jpg image needs to be the same size in pixels as the print
output. If you selected the "Add a background.jpg image which can be edited to add logos etc." option
when running the setup wizard there will already be a dummy background.jpg image in the photobooth
images folder.
The various screens presented to the user are defined using JPEG images saved in the photobooth
images folder. The look of your booth can be customized simply by editing the screen JPEGs using an
image editor such as Photoshop Elements. The screen that is shown when the booth is ready to take
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the next set of photos is called ready.jpg. Please see the section on images displayed to the user for
more details.
There are many other settings that can be adjusted. Please see the section on photobooth setup for
more information. There is a series of articles on our website which includes lots of useful information
about photobooth shooting and a section giving answers to frequently asked questions.

9.2

Print Layout Editor
The print layout editor can be displayed by clicking on the "Print layout" photobooth shortcut button in
the main window or by displaying the "Photobooth settings" dialog (File->Photobooth settings...) and
clicking on the "Settings..." button to the right of the "Custom layout" checkbox.
Note: if the photobooth shortcut buttons aren't displayed in the main window you can display them by
selecting View->Photobooth Shortcuts

The right hand side of the window displays the print layout. Photos and captions can be edited
interactively by clicking on them using a mouse and then dragging to position, resize or rotate them.
The left hand area of the window contains controls to help with the layout and for loading and saving
settings:
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A Quick tour of the editor
This section gives a quick overview of some of the ways to edit the layout.
Click on the "Preset layouts..." button, select one of the preset layouts (e.g. "1 large, 3 small") and then
click on the "OK" button. The right hand side of the editor should show the page layout similar to the
screenshot above.
Left click the mouse on photo 2 to select it:
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The photo will be highlighted with a dashed red line to show that it has been selected. It will also have
a resize control in each corner and a dashed line in the center with a control for rotating the image.
Move the mouse over the center of the photo (a hand cursor will be displayed) and then click on hold
down the left mouse button and drag the photo to a new position and then release the left mouse
button. The keyboard cursor keys can also be used to adjust the position of the photo e.g. pressing the
left cursor key will move the photo one pixel to the left. Hold the shift key down and press one of the
cursor keys to move the photo 10 pixels in that direction.
Resize the photo by moving the mouse over one of the corners of the photo (a resize cursor will be
displayed) and then click on hold down the left mouse button and drag the corner to resize the photo
and then release the left mouse button.
Rotate the photo by moving the mouse over the control area at the end of the dashed line in the center
of the photo (a rotate cursor will be displayed) and then click on hold down the left mouse button and
move the mouse to rotate the photo and then release the left mouse button. The keyboard cursor left
and right keys can also be used to rotate the photo when the ctrl key is held down e.g. hold down the
ctrl key and press the left cursor key to rotate the photo 1/2 degree to the counter clockwise. Hold the
ctrl and shift keys down and press cursor left or right to snap the rotation to the nearest 15 degrees
and then rotate in 15 degree steps.
Select all the photos by typing Ctrl+A or by right clicking on a photo as selecting "Select all". The
selected photos will be highlighted with dashed red lines and can be dragged as a group by holding
down the left mouse button.
When a photo is selected it is also highlighted in the image position display in the top left corner of the
edit window. The size, position and rotation of the photo can be entered directly by clicking on the "..."
button for that image. Click on the dropdown list to change the photo number (or select "None" to
remove it or "QR code" set it to a QR code).
Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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Check the "Enable caption" checkbox if it is not already checked. Caption 1 should now be displayed
highlighted on the print layout (if it isn't visible click on the "Move to center" button). Type in the edit box
to change the caption text or click on the "..." button to the right of the "Font:" label to change the font
or to the right of the "Font color:" display to change the color. Click on the "OK" button and the font
should remain highlighted. You can drag, resize and rotate the text using the mouse just the as with a
photo.
Click on the "Undo" button a few times (or type ctrl+Z) a few times to undo the changes. Then click on
the "Redo" button (or type ctrl+Y) to redo the changes.
Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.

Printer setup and margins
It is a good idea to check the printer settings and printer margins before designing the layout or
running the photobooth setup wizard. To do this click on the "Printer Setup..." button and the "Printer
Setup" dialog will be displayed:
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Select the required printer from the dropdown list. If your printer isn't listed you may need to install the
printer drivers first (please see the Windows help files or printer manuals for information on how to do
this).
Click on the "Setup Printer..." button to select the page size, print orientation, print resolution and other
printer settings.
Note: if you want to print a double strip of three or four images and are using a dyesub printer that can
cut 4"x6" pages into two 2"x6" strips you need to select the 2x6 cut option in the printer driver.
Click on the "Portrait" or "Landscape" radio buttons to change the printer page orientation.
If the selected printer is setup with a page size of 4"x6" and a print resolution of 300 DPI or 600 DPI
(most professional dyesub printers support this) the "Center page" button will be enabled. You can
press this button to setup the margins to center the page in the printable area. This should produce
correctly centered prints with most printers.
Click on the "Test Print" button to print a page to help setup the printer margins. The test print from a
DNP DS40 printer will look something like this:
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In the enlarged view of the top margin shown below the top margin can be read off the ruler as 14
pixels:

And in the enlarged view of the bottom margin shown below the bottom margin can be read off the
ruler as 26 pixels:

© 2016 Breeze Systems Ltd

36

PSRemote

Check the top, left, right and bottom margins and enter the values in the printer setup dialog, It is worth
spending time setting up the print margins accurately as this will save time later.

Preset Layouts
The "Preset layouts..." button can be used to help design a number of different popular layouts using
three or four photos. These include a double strip of three or four photos, a single strip of three or four
photos, one large image with a row of three smaller images below and two rows of two images. Simply
select the layout you want, adjust the page margins and image spacing and then press the OK button
and the software will work out the settings for you:

Select the preset layout from the list of layouts in the top left of the window. The right side of the
window shows a preview of the selected layout. The spacing between photos and the top, left, right
and bottom margins can be adjusted using the edit boxes on the left of the window.
Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.
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Click "OK" to copy the layout to the print layout editor.

Editing Photo Positions
A photo can be added to the layout by selecting the photo number from one of the spare image
dropboxes showing "None" in the top left corner of the editor window. Alternatively a photo can be
hidden by setting its dropdown list to "None".
The size, position and rotation of the photo can be edited by left clicking on the photo to select it and
then using the mouse or keyboard cursor keys:

Move the photo by moving the mouse to the center of the photo (a hand cursor will be displayed) then
hold down the left mouse button and drag the photo to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the photo one pixel at a time. Hold
down the shift key and use the cursor keys to move the photo 10 pixels at a time.
Resize the photo by moving the mouse to one of the circular control handles in the corners (the resize
cursor will be displayed) then hold down the left mouse button and drag the corner to resize the photo.
The aspect ratio of the photo will be preserved (i.e. the ratio of the width to the height). Hold down the
shift key if to resize the photo without preserving the aspect ratio (this may result in the photos being
cropped when they are printed).
Rotate the photo by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the photo (the rotate cursor will be displayed) then hold down the left mouse button and
move the mouse to rotate the photo.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the photo in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate
the photo in 15 degree increments.
Photos are printed in the order in which they are defined and so if the second photo's position overlaps
the first photo the second photo will be printed on top of the first photo. You can change the order in
which photos are printed by right clicking on a photo and selecting "Move to back", "Move back",
"Move forward" or "Move to front".
You can also enter the photo position and angle directly by clicking on the "..." button for that photo on
the left side of the editor window and it will display the "Edit Position" dialog:
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You can also edit the position by right clicking on the photo and selecting "Edit image position..." from
the popup menu.
The left and top entries specify the distance in pixels of the photo from the left and top edges of the
page respectively. The layout in the print editor window will be updated automatically as you change
the settings. If the photo isn't visible you can press the "Move to center" button to center it on the page.
The width and height entries specify the width and height of the photo in pixels. To preserve the aspect
ratio of the photo you can enter 0 for the width or height and the software will replace this with the
correct value when you press the "OK" button.
Note: Entering a width and height with a different aspect ratio from the photos taken by the camera
(3:2) will result in the photo being cropped when it is printed.
The angle entry specifies the clockwise rotation of the photo in degrees.

Editing QR Codes
A QR code can be added to the layout by selecting "QR code" in one of the spare image dropboxes
showing "None" in the top left corner of the editor window. Alternatively the QR code can be hidden by
setting its dropdown list to "None". The size, position of the QR code can then be edited in exactly the
same way as a photo (described in the section headed "Editing Photo Positions" above).
The text encoded in the QR code can be edited by right clicking on the QR code and selecting "Edit
QR code..." from the popup menu. The "QR Code" dialog shown below will be displayed:
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Type in the text you want to be encoded in the QR code. Normally this is a URL which needs to be
prefixed with http://
The QR code display will be updated automatically as you type in the text. You can test the QR code
by pressing the "Test URL" button to open it in a web browser. You can also test the QR code by
scanning it with a cell phone.
The error correction dropdown list specifies amount of error correction encoded in the QR code. A
"Medium" setting should be suitable for most uses. You may wish to use the "Low" setting if the URL is
very long or the QR code is to be printed very small.
Note: The QR code text can also be edited by selecting File->Edit QR code from the main program
window.

Editing Caption Positions
Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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You can also edit the caption by right clicking on the caption and selecting "Edit caption..." from the
popup menu.
Select the caption you wish to edit using the dropdown box at the top and then check the "Enable
caption" checkbox if it is not already checked. The caption should now be displayed highlighted on the
print layout (if it isn't visible click on the "Move to center" button). Type in the edit box to change the
caption text. Captions span more than one line and can contain tokens such as such as %d for the
date and %t for the time the sequence started, {comment} for the comments entered in the main
screen and {filename} for the filename used for the JPEG copy of the print layout. Please see the
section on tokens for a list of tokens available.
Click on the "..." button to the right of the "Font:" label to change the font, size and style or to the right
of the "Font color:" display to change the color.
Use the "Left offset" and "Top offset" entries to specify the position of the text. This is specified in
pixels from the top left corner of the page. Use the angle entry to specify the angle of the text. This is
specified as degrees rotation in a clockwise direction.
Normally text is left justified (the "Alignment" dropdown list is set to "Left justified") and its position on
the screen is measured from the top left corner of the text area.
If the "Alignment" dropdown list is set to "Centered" the text will be center justified and the position will
be measured from the top center of the text area.
If the "Alignment" dropdown list is set to "Right justified" the text will be right justified and the position
will be measured from the right side of the text area.
Click on the "OK" button to the save the changes. The caption will be selected in the print layout:

The size, position and rotation of the can then be edited using the mouse or keyboard cursor keys
similar to moving and resizing photos.
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Move the caption by moving the mouse to the center of the caption (a hand cursor will be displayed)
then hold down the left mouse button and drag the caption to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the caption one pixel at a time. Hold
down the shift key and use the cursor keys to move the caption 10 pixels at a time.
Resize the caption by moving the mouse to one of the circular control handles in the corners (the
resize cursor will be displayed) then hold down the left mouse button and drag the corner to resize the
caption.
Alternatively hold down the ctrl key and use the up and and down cursor keys to resize the caption.
Rotate the caption by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the caption (the rotate cursor will be displayed) then hold down the left mouse button
and move the mouse to rotate the caption.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the caption in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate
the caption in 15 degree increments.

Aligning, sizing and moving multiple items
All the currently defined photos, captions and QR codes can be selected by typing ctrl+A (or by right
clicking and selecting "Select all"). Alternatively just photos can be selected by typing Ctrl+P (or by
right clicking and selecting "Select all photos"). You can refine the selection by holding down the ctrl
key and clicking on the item to be added or removed from the selection.
Tip: All captions can be selected by typing Ctrl+P to select all photos followed by Ctrl+I to invert the
selection (this will unselect all photos and select all captions).
A group of selected images can be moved by holding down the left mouse button and dragging them
to the new position or by using the keyboard cursor keys.
There are various options for aligning a group of selected items e.g. left align so that a group of
images are arranged in a column. To align the currently selected elements right click the mouse on the
reference element and select the required alignment from the "Alignment" menu of the popup menu.
The selected elements will be moved to align them with the reference element.
Note: If this doesn't produce the required result simply type ctrl+Z to undo the changes.
A group of photos can be spaced evenly by selecting them in order and then right click on any of the
selected images and select "Space photos evenly". The order in which the photos are selected is
important because the middle photos will be spaced evenly between the positions of the first and last
photos in the selection. To select the photos in the right order simply left click on the first photo and
then add the remaining photos to the selection in order by holding down the ctrl key and clicking on
them.
A group of photos can be set to the same size and angle as a reference photo by selecting them and
then right clicking on the reference photo and selecting "Make photos same size and angle".

Background Color and background.jpg
Normally the page background is white but it can be set to any color by clicking on the "..." button next
to the colored square besides the "Show background color" checkbox.
A JPEG image named background.jpg can also be used as a background. This is useful for adding
logos or fancy captions to the print or to add frames around the photos. Ideally the background.jpg
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should be the same size in pixels as the printed output (e.g. 1844 x 1240 pixels for a 6"x4" print from a
DNP DS40 printer). The background.jpg will be centered on the page and so if it is bigger the excess
will be cropped from the top, left, right and bottom or if it is smaller it won't fill the page.
Tip: Set the background color to the same color as the edges of the background.jpg to avoid white
strips on the edges of the page if the background.jpg doesn't fill it.
The background.jpg should be saved in your photobooth images folder (this is displayed in the title bar
of the print layout editor window). You can copy a JPEG image into your photobooth images folder by
clicking on the "Import background..." button.
To delete a background.jpg image first press the "OK" button to save the print layout and close the
print layout editor window. Then delete the background.jpg from your photobooth images folder.
Note: If the positions of photos and captions don't quite line up with an imported background.jpg they
can be moved by typing ctrl+A (to select all) and then pressing the cursor keys.

Headers and footers
For backwards compatibility with previous releases the print layout can also display a header image
named header.jpg at the top of the page and a footer image named footer.jpg at the bottom of the
page. It is recommended that you avoid using headers and footers and use the background.jpg
instead. This will make it easier save layouts for future reference without them being specific to a
particular printer model.

Overlay
An option overlay can be placed over the photos by placing an PNG image named overlay.png in your
photobooth images folder. You can copy a PNG image into your photobooth images folder by clicking
on the "Import overlay..." button.
The overlay.png should be saved as a 24-bit color PNG file with an 8-bit alpha channel containing
transparency information.
To delete an overlay.png image first press the "OK" button to save the print layout and close the print
layout editor window. Then delete the overlay.png from your photobooth images folder.
Please see the section headed "How to create PNG images using Photoshop" for notes on how to
create an overlay.png file.
There is an example PNG file named example_overlay.png in the installation folder which can be used
for testing.
Tip: The current layout can be saved as a JPEG file by holding down the Shift and Ctrl keys and then
clicking on the "Print Test Page" button. This JPEG image can then be loaded into a photo editor such
as Photoshop to add logos, captions etc. and then saved as a background.jpg or overlay.png image
which can be imported into the layout.

Hiding and showing elements
Use the various "Show" checkboxes to control what is displayed in the print layout preview. This is
useful if you want to simplify the preview display to make it easier to adjust the photo positions.
Please note: Unchecking the "Show" checkbox for an element only affects the print layout preview
and does not affect the final prints.
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Undo and Redo
Most actions can be undone by clicking on the "Undo" button or by typing ctrl+Z and redone by clicking
on the "Redo" button or typing ctrl+Y.
You can't undo the "Printer setup", "Import background...", "Import overlay..." or "Import layout..."
actions.

Exporting and importing layouts
You can save a print layout for future reference by clicking on the "Export layout..." button. This will
save the entire layout including any overlay and background images to a single file with a .pblt file
extension.
A previously saved layout can be imported by clicking on the "Import layout..." button. It should be
possible to import layouts defined for any similar printer (i.e. one with the same page size and print
resolution) provided the print margins were set accurately.
Please note: If your photobooth images folder contains a background.jpg or overlay.png image they
will be deleted or overwritten when importing a print layout.

9.3

Advanced Photobooth Setup
This section gives detailed information about the various photobooth settings. If you want to get started
as quickly as possible you can use the photobooth setup wizard to set everything up and then come
back to this page later to find out more about tweaking the various settings.

Setting up the page layout
To setup photobooth operation select "Photobooth Settings..." from the File menu and the dialog below
will be displayed:
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First select the number of images to be taken and how they are arranged. This could be a single
image on one sheet of paper (1 image, 1 row, 1 column), a passport style strip of images (e.g. 4
images, 4 rows, 1 column), 2x2 grid of 4 images as shown above or any other arrangement of up to 20
images arranged in a grid. Alternatively select "Custom layout" and click on the "Settings..." button next
to the checkbox to position each image manually on the page (this is described in more detail later).
Next select the delay before taking each photo and how long the shot just taken is displayed on screen
when shooting in fullscreen photobooth mode (this can be disabled by setting the time to 0). After
taking each photo a preview can be displayed on the screen for a specified number of seconds (set
this to 0 to disable the preview). Please note that the preview may not fill the screen if the image size/
quality setting in the main PSRemote is set to "small". The delay before taking the first photo can be
set to a different value than that for the remaining photos. This is useful when using a touchscreen as
it means a longer delay can be set before the first photo to give people time to move back from the
touchscreen.
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Some older PowerShot models have a significant delay when taking a photo and this can result in the
photos being taken later than expected. This delay can be reduced by using AF lock but if the delay is
still a problem enter a value for the delay in 1/10th sec in the "Camera delay" edit box e.g. to enter a
delay of half a second enter 5 in the camera delay edit box. Please take care when changing this
setting because too large a value may upset the timing of the photos.
Note: AF lock can be selected or updated in fullscreen photobooth using the keyboard shortcut Ctrl+A.
When the "Minimum duration in seconds before closing 'processing' screen is set to 0 the 'processing'
screen will be close as soon as the data has been sent to the printer. The 'processing' screen can be
displayed for longer by adjusting this value. This is useful if you want to keep displaying a message
such as "Thank you! Your photos are being printed, please leave the booth now" for longer than it
takes to print the images.
The inactivity timeout can be enabled by setting the "Inactivity in secs" value to the required number of
seconds e.g. 120. When the inactivity timeout is enabled the photobooth will automatically switch to
standby mode and display the welcome.jpg screen if there is no activity (e.g. touching the screen to
select different options) within the timeout.
Select the "Auto standby" option to have the booth automatically switch to standby mode at startup and
after each set of photos. You can switch back to ready mode by typing F6 (toggle between standby
and ready modes) or Ctrl+Alt+F6 (switch from standby to ready mode) or by using the "Toggle standby
mode" or "Switch from standby to ready" touchscreen actions.
The countdown text is displayed before shooting each image and is updated every seconds. The
following tokens can be used:
@imageNumber@ - the shot number in the photobooth sequence
@numberOfImages@ - the number of images in the photobooth seconds
@secsToNextPhoto@ - the number of seconds until the next photo in the sequence is taken
Select "Enable live viewfinder for fullscreen photobooth shooting" to display live view images in the
fullscreen photobooth shooting mode. The live viewfinder image can be mirrored so that the user sees
the image the same way round as when looking in a mirror. Use the height setting to resize the live
viewfinder image.
By default the live view images are displayed centered at the top of the screen with the count down text
beneath. The position of the live view images can be adjusted using the "Left offset" and "Top offset"
settings. These specify the offset in pixels from the left and top of the screen respectively. If the left
offset is set to -1 the live view display will be centered horizontally on the screen.
If the count down text offset is set to 0 the count down text is automatically displayed centered in the
spare space above or below the live view images (depending on whether there is more space above or
below the live view images). Please make sure there is enough space for the count down text when
setting the live view size and position.
Alternatively the countdown text can be manually positioned on the screen by setting the offset to a
non-zero value. This value is the number of pixels the text is offset from the top of the screen. If
required, the countdown text can be positioned so that it overlays the live view images.
Normally the live view display, if enabled, is shown before each image in the sequence is taken. When
the "Only display Live View images for the first shot in the sequence" option is selected live view
images are only displayed to the user before taking the first shot of the sequence and are hidden
during the rest of the sequence.
Please note: Live viewfinder images from PowerShot cameras are only 320x240 pixels in size and will
appear pixellated if they are enlarged too much.
The live view display can be cropped if required by selecting fullscreen photobooth mode and holding
down the Shift key and using the cursor left and right keys to increase or decrease the cropping.
Cropping removes equal amounts from the left and right of the live view image when displaying live
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view images in landscape orientation and from the top and bottom when using portrait orientation.
When adjusting the live view cropping a status message showing the amount of cropping is shown
briefly in the bottom right hand corner of the screen.
An optional overlay image can be displayed over the live view images in fullscreen photobooth mode to
add fun effects such as superimposing a body builder's body with the user's head. It can also be used
to create fancy borders for the live view images to give the booth a more custom feel. The overlay
image should be a PNG file with transparency information in the alpha channel. It should be in
landscape orientation with an aspect ratio of 4:3 e.g. 320x240 pixels in size. The overlay file should be
named live_view_overlay.png and saved in the photobooth images folder.
Please note: The live view overlay image only affects the live view images displayed to the user and
won't appear in the printed output. To overlay the images in the printed output create a copy of the
live_view_overlay.png file called image_overlay.png and save it in the the photobooth images folder.
DSLR template compatibility mode (3:2 aspect ratio)
Photos taken using PowerShot cameras have an aspect ratio of 4:3 which is slightly squarer and less
wide than photos from DSLR cameras which have an aspect ratio of 3:2.Select "DSLR template
compatibility mode" if you want to share print layout templates with the DSLR versions of Breeze
Systems' photobooth software (DSLR Remote Pro for Windows and NKRemote) or to download free
templates from the Breeze Systems website.
DSLR template compatibility mode works by cropping a small portion from the top and bottom of
photos before they are added to the print layout so that they have the same aspect ratio as photos
from DSLR cameras. The live view display is also cropped by the same amount to ensure that what
users see in the live view matches what is printed.
The aspect ratio of an image is the ratio of the image width to the image height. The difference
between the aspect ratio of images from a PowerShot camera (4:3) and images from a DSLR camera
(3:2) is shown below:

Output Settings
Click on the "Settings..." button to the right of the output options to display the output settings dialog
which allows you to configure the print preview and how JPEG copies of the printed output are
handled:
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The "Output:" drop down list allows you to specify whether photos are printed only, printed with a JPEG
copy of the layout saved in "prints" sub folder, a JPEG copy of the layout is saved in the "prints" sub
folder without printing or no output action is taken. (This is the same as the "Output:" drop down list
displayed in the main photobooth settings dialog).
Select "Display thumbnails" to display a small thumbnail of each photo. The thumbnails can be
arranged vertically down one side of the screen or horizontally across the top or bottom of the screen.
Click on the "Settings..." button to
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The left offset specifies the distance in pixels of the first thumbnail from the left edge of the screen. If a
negative value is specified the distance will be measured from the right edge of the screen e.g. and
value of -1 will place the first thumbnail on the right of the screen. The top offset specifies the distance
in pixels of the first thumbnail from the top edge of the screen. If a negative value is specified the
distance will be measured from the bottom edge of the screen e.g. and value of -1 will place the first
thumbnail on the bottom of the screen.
The thumbnail width specifies the width of the thumbnail in pixels (the height of the image will be
calculated automatically using the aspect ratio of the photo).
The horizontal and vertical spacings specify the positions of the remaining thumbnails relative to the
first thumbnail. The settings in the screenshot above will place four thumbnails 240 pixels wide across
the bottom of the screen and will be centered horizontally if the screen resolution is 1366 x 768.
The default setting is to only display thumbnails during the photobooth countdowns when taking the
photos and not to show them at the end of the shooting sequence on the processing or printing
confirmed screens. Select the "Display thumbnails on processing and printing confirmed screens" if
you also want the thumbnails to be displayed at the end of the shooting sequence when the processing
or printing confirmed screens are displayed.
Select "Display print preview and wait for confirmation before printing" if you want to be able to decide
whether to print the images or not (this is the same as the "Confirm before printing" checkbox
displayed in the main photobooth settings dialog). When this option is selected the print layout will be
displayed on the screen with "Print" and "Cancel" buttons in the top left hand corner. Users should click
on the "Print" button (or press the Enter key) to print the images or click on the "Cancel" button (or
press the Esc key) to continue without printing. If the touchscreen input mode is selected and
touchscreen actions for confirm or cancel printing are defined the "Print" and "Cancel" buttons will not
be displayed. The touchscreen sensitive areas can be displayed using the confirm_printing.jpg screen
image.
If a confirm_printing.jpg screen image is in the photobooth images folder this will be used for the
background to the print confirmation window to allow instructions or touchscreen buttons to be
displayed.
If a printing_confirmed.jpg screen image is in the photobooth images folder this will be displayed if the
user selects printing. This allows the processing.jpg screen to show a message like "Processing,
please wait..." and the printing_confirmed.jpg to display a message like "Thank you, please leave the
booth now. Your photos are being printed outside."
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The print preview can be rotated by 90 degrees CW, 90 degrees CCW or 180 degrees using the
rotation setting. The size and position of the print preview can be set print preview offset, width and
height settings. If these are all set to zero the print preview will be sized to fill the window and will be
centered on the screen. The print preview can be moved on the screen, e.g. to make space for the
print confirmation buttons, using the left and top offset settings. For example to leave a space 200
pixels wide on the left of the screen set the print preview left offset to 200. If the print preview width
and height settings are set to 0 the print preview will be resized to fill the rest of the screen. Set the
print preview width and height settings to values other than 0 to specify the size of the print preview
image.
Use the "Timeout (secs):" to specify a timeout for how long the print preview should be displayed (the
default timeout is 300 secs). Set the timeout action dropdown list to the action that should be
performed when the timeout occurs (the default setting is to cancel the print).
Use the sharing options to enable the sharing of photos by uploading to the user's own Facebook
page, Tweeting, texting (MMS or SMS) or by sending photos email. Please see the section on
uploading to social networks for information on how to set this up.
Select the "Share animated GIFs" to enable the sharing of animated GIFs by email, Facebook, Twitter
or texting. When sharing animated GIFs on Facebook the GIFs are hosted on www.giphy.com
Please note: When sharing animated GIFs please note that the files can be large and so it is best to
keep the image size small to avoid excessively large files for sharing. This can result in the animated
GIF appearing very small in the sharing screen. The preview can be made large by increasing the
"Max percentage upscaling setting" e.g. set this to 200 to display the animated GIF 2x normal size or
300 for 3x normal size.
Select the "Printing" option to give users the option to print photos in the sharing screen. Users can
print the photos by typing P or by using the "Sharing: Print photos" touchscreen action. Photos can be
printed if the output is set to "Print and save JPEG copy" or "JPEG copy only". The share_printing.jpg
screen is displayed for a minimum of 5 seconds each time the user selects printing from the sharing
screen. The number of prints that can be made from the sharing screen can be limited by clicking on
the "Settings..." button:

Set the "Number of prints allowed" to the maximum number of prints allowed or to 0 if there is not limit.
Then enter the message that is displayed if the user tries to print more copies than is allowed.
If the user prints the photos one or more times from the sharing screen the photos additional copies
won't be printed if the output is set to "Print and save JPEG copy". If the user doesn't print the photos
from the sharing screen and the output is set to "Print and save JPEG copy" the photos will be printed
when the sharing screen is closed using the currently selected number of print copies.
By default the sharing screen shows a print preview image centered on the screen with a height of no
more than 2/3 the height of the screen. This setting can be overridden by setting the preview left, top,
right and bottom settings to non-zero values. The left value is the offset in pixels from the left edge of
the screen. The top value is the offset in pixels from the top edge of the screen. The width and height
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values specify the maximum width of the preview image in pixels.
Select the "Create animated GIF of photos" option to created an animated GIF of the photos taken
with an optional overlay and title page.
Please see the Animated GIF section for details on how to set up animated GIFs in stills photo booth
mode.
When the output option is set to "Print and save JPEG copy" or "JPEG copy only" the filename of the
JPEG copy of the printed output can be specified using the "Filename for JPEG copy of output:" edit
box. This value can use tokens to specify values which are determined at run time e.g. %d represents
the date and %t the time. Please see the section on tokens for a list of available tokens. The JPEG
copy of the printed output is an exact copy of what is sent to the printer and can be used for reprints
after an event.
An optional second copy of the printed output can be saved in a different folder by selecting the "Copy
JPEG copy of printed output to folder:" option. Click on the "Settings..." button to display the "Copy
JPEG Settings" dialog:

You can specify the folder where the additional copy of the printed output is saved using the "Folder:"
edit box. If this is left empty the JPEG will be saved in a sub folder named "copy". You can also enter
the full pathname of the folder where the images should be copied to (e.g. "C:\Print copies") or the
name of a different sub folder (e.g. "Backup"). The folder name can also use tokens to specify values
which are determined at run time. The second copy of the print output can also be cropped, resized
and rotated before it is saved.
Photobooth Start options
The following start options are available:
"Keyboard only (ignore This is the default setting where the photobooth sequence can be started
mouse or touchscreen using the normal keyboard shortcuts e.g. F4
clicks)"
"Left click anywhere to This setting allows a mouse or a touchscreen to start the photobooth
sequence. The user simply needs to click the left mouse button or press
start"
anywhere on the display if using a touchscreen
"Left click to start, right This setting allows a standard mouse to be used to start the sequence (left
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click) or to toggle between B&W and color modes (right click)
This setting is designed for touchscreens and requires the user to click in
the top left fifth of the screen to start the sequence. The ready.jpg image
should be edited to show the user where to touch the screen to start the
sequence.
This setting is designed for touchscreens and requires the user to click in
the top left fifth of the screen to start the sequence in color and the bottom
left fifth to start it in black and white. The ready.jpg image should be edited
to show the user which areas to touch to start the sequence.
This setting allows up to 10 areas on a touchscreen to be given different
actions (described in more detail below)

Touchscreen Settings
Up to 10 areas can be defined on a touchscreen to control different photo booth settings such as
starting the sequence, switching between color and B&W, selecting the number of print copies etc.
First select the "Touchscreen" option in the "Start options" dropdown list and then click on the
"Settings..." button to display the touchscreen settings dialog:
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Select the action using the dropdown lists on the left and the area on the touchscreen that activates
the action using the corresponding "Left", "Top", "Right" and "Bottom" edit boxes. The values entered
in the edit boxes are the screen coordinates in pixels with the origin in the top left corner. The example
in the screenshot above defines three sensitive areas on the touchscreen:
1. A square area 300x300 pixels in the top left corner of the screen which starts the photobooth
sequence (action is set to "Start")
2. A smaller rectangular area 300x150 pixels in size located below the first area which selects B&W
mode
3. A second area similar to item 2 which selects color mode
Touchscreen actions can also be viewed or edited interactively using a mouse by clicking on the
"Show/edit touchscreen areas..." button. When the touchscreen action editor is first opened it will
display the ready.jpg screen and the touchscreen actions for as boxes with white outlines and green
text indicating the action. The action can be moved by clicking in the box and moving the mouse with
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the left button held down. The size of the box can be adjusted by dragging the corners with the left
mouse button held down. Touchscreen actions can be deleted by right clicking on the action and
selecting "Delete action" from the menu. New actions added by right clicking the mouse and selecting
the "Add action...". Different screens can be displayed by right clicking the mouse and selecting the
required screen.
Exit the touchscreen action editor by pressing the escape key or by right clicking the mouse and
selecting "Exit" from the menu. If the touchsrceen actions have been modified a confirmation dialog
will be displayed asking you if you want to save the changes.
Please note: the touchscreen action editor only edits the positions of the touchscreen actions. It
doesn't edit the JPEG screen images which display the graphics for the touchscreen buttons - to do
this you need to use an image editor such as Photoshop Elements.
An optional password can be used to protect the "Exit fullscreen photobooth" action by entering the
password in the "Photo booth exit action password" field. Many photo booth operators define a secret
touchscreen action on the screen to exit photo booth mode which can cause problems if users find it
because it will allow them to break out of full screen photo booth mode. Using a password to protect
this should prevent problems if users manage to find the secret exit photo booth mode touchscreen
action.
An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. This information is stored in
the XML file saved after each shooting sequence. Use the dropdown list to select when the
touchscreen keyboard should be displayed and the "Test keyboard..." button to test it. The "Timeout
(secs):" value allows a timeout for the keyboard to be specified. If the user does not touch the
touchscreen before the timeout the touchscreen keyboard will be automatically closed.
Please see the section describing the touchscreen keyboard for more details.
Saving settings for future reference and using profiles
Settings can be saved to file for future reference by pressing the "Save..." button and reloaded by
pressing the "Load..." button. This is makes it possible to define a number of different layouts which
can be selected before entering fullscreen photobooth mode. Please note that layout depends on the
size of the page which is affected by the printer settings. The values saved for one setup may not
produce the same results if a different printer is used or the page or resolution settings have changed.
The image download directory specified in preferences is not saved with the photobooth settings, but
you can use the tokens {photoboothDir} and {photoboothSubdir} to specify a different output directory
for each profile.
{photoboothDir} gives the full path of the photobooth images folder e.g. C:
\Photobooth\Layouts\MyLayout
{photoboothSubdir} gives the name of the photobooth subfolder e.g. if the photobooth images folder is
C:\Photobooth\Layouts\MyLayout then {photoboothSubdir} would become MyLayout
For example:
strips_profile: outputs standard photobooth strips to the default printer and uses C:
\Photobooth\Layouts\strips as its photobooth images dir
cubes_profile: takes four photos with the output set to 'none' and uses C:\Photobooth\Layouts\cubes
as its photobooth images dir. Its output directory is then monitored by the Hot Folder Prints utility which
formats the images as a photo cube and sends them to a different printer.
To make this work the download directory in preferences could be set to C:
\Photobooth\Output\{photoboothSubdir}. This would save images from the strips_profile to C:
\Photobooth\Output\strips and the cubes_profile to C:\Photobooth\Output\cubes. The Hot Folder Prints
utility could then be setup to monitor the C:\Photobooth\Output\cubes folder for images and print them
out automatically when the required number of images are available.
Profiles allow you to use a keyboard shortcut (or touchscreen action) to automatically switch between
different sets of saved settings. To assign a profile to a keyboard shortcut click on the "Profiles..."
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button at the bottom of the photobooth settings dialog to display the following dialog:

Then click on "..." button for the appropriate profile and select a previously saved set of photobooth
settings. In the screenshot above profile 1 (keyboard shortcut SHIFT+CTRL+1) loads the settings file
photobooth_settings1.xml and profile 2 (keyboard shortcut SHIFT+CTRL+2) loads the settings file
photobooth_settings2.xml. Profiles can be used to allow users to selects different sets of photobooth
settings e.g. profile 1 might be a traditional layout of two columns of four images and profile 2 might be
a custom layout with one large image and several smaller ones. Profiles can be selected using the
touchscreen actions (described above) allowing a user to easily switch between different settings.
The tokens {photoboothDir} and {photoboothSubDir} can be used to specify the pathname of the
profile file to be loaded. The tokens are replaced with the value of current photobooth images folder
and provide a way to use more than 8 profiles.
The default profile setting can be used to ensure the photobooth starts up in a known state and is reset
to a known state at the end of each photobooth shooting sequence e.g. setting the photobooth to stills
mode, color photos and one set of prints.

Print layout
Use the output dropdown list to select whether the output is sent to a printer only, saved as a JPEG
only or both printed and saved as a JPEG. The JPEG with the printed layout is saved in a subfolder
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called "prints".
The print can have an optional background with a header and or footer image. When PSRemote
prepares the image for printing it looks for the following files in the image folder:
background.jpg - optional image which is tiled to fill the background of the printed page
header.jpg - optional image which is centered and placed at the top of the page
footer.jpg - optional image which is centered and placed at the bottom of the page
left.jpg - optional image which is centered vertically and placed on the left of the page between the
header and footer
right.jpg - optional image which is centered vertically and placed on the right of the page between the
header and footer
middle.jpg - optional image which is centered vertically and placed between each column of images
overlay.png - optional image which is overlays the page and uses transparency information stored in
the alpha channel

The images are then arranged in a grid which fills the printable area of the page less any space taken
up by a header or footer image. If the "Rotate image to maximize size" checkbox is selected the
images are rotated through 90 degrees if this would give a larger image. e.g. if the printable area for
the image within the grid is 80mm high and 50mm wide and the image was shot in landscape
orientation it would be rotated by 90 degrees to better fill the printable area.
If the number of images matches the number of rows the images can be repeated in each column by
selecting "Repeat images to fill empty columns". This is useful when printing strips of images on paper
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from a dye sublimation printer e.g. two copies of 4x1 strips on a sheet of 8x6 paper.
Custom layout
Images can be manually laid out by selecting the "Custom layout" option which allows the size, position
and rotation of each image to be specified on the page. This allows complex layouts where the images
can be different sizes and don't need to be arranged in a grid. It is also simpler to setup for many less
complex layouts and often these can be achieved using a single background.jpg containing logos and
other graphics.
After selecting "Custom layout" click on the "Settings..." button to display the dialog below:

Up to 10 images can be positioned using the custom layout. The number of the image to be printed is
selected using the drop down list and the position of each image is specified in pixels on the page with
the point (0, 0) in the top left corner. The size is also specified in pixels. If both the width and the height
are specified the image will be sized to fill the width and height and any excess will be cropped.
Alternatively either the height or the width can be set to 0 and the image will be resized to match the
specified size without cropping.
For example: assuming an image size of 1600x1200 (one of the medium settings from a Canon
PowerShot G10) the resultant image size for various width and height values would be:
width=1000, height=0: image resized to 1000 pixels wide by 750 pixels high (the app calculates the
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height as 1000*1200/1600)
width=1000, height=800: images resized to 1067 pixels wide by 800 pixels high and then cropped by
equal amount left and right to give a final image size of 1000x800
width=0, height=800: images resized to 1067 pixels wide by 800 pixels high (the app calculates the
width as 800*1600/1200)
Each image can also be rotated clockwise by between 0 and 359.9 degrees.
The settings in the screen shot above show how a simple layout of two strips of four images printed on
6"x4" paper using a 300 dpi printer can be defined.
The page size in pixels can be displayed by first setting up the printer to the required page size and
resolution and then pressing the "Print Info..." button. The layout can be previewed on computer
screen by pressing the "Preview" button or printed by pressing the "Print Test Page" button. Hold the
"Shift" key down and click on the "Print Test Page" button to print a printer calibration image with index
marks showing the extent of the printable area.
The "Preset layouts..." button can be used to help design a number of different popular layouts using
four photos. These include a double strip of four, a single strip of four, one large image with a row of
three smaller images below and two rows of two images. Simply select the layout you want, adjust the
page margins and image spacing and then press the OK button and the software will work out the
settings for you.
When the custom layout option is used the number of rows and columns, image border, rotate and
crop settings in the main photobooth settings dialog are not applicable and are grayed out.
Please note: The custom layout functionality was revised in PSRemote v1.9 and custom layout
designs from previous releases may need to be updated if they use the "Copy left half of page to right
to create a double strip" option.
Other output options
The images can be sharpened by selecting the "Sharpen images" checkbox and specifying a
sharpening amount in the the range 0 to 100. The amount of sharpening required depends on
personal taste, the camera and the printer. A value of around 75 is a good staring point.
Photos can be printed in color, pure black and white or toned black and white by selecting the
appropriate option from the dropdown list headed "Print photos:". You can also switch between these
options when the software is running in fullscreen photobooth mode by using the following keyboard
shortcuts: Ctrl+C to select color, Ctrl+B to select black and white, Ctrl+T to select toning, Ctrl+W to
toggle between color and B&W and W to cycle through color, B&W and toning.
When the "toned" option is selected the hue and saturation settings can be adjusted when the software
is running in fullscreen photobooth mode by using the following keyboard shortcuts: Ctrl+cursor left/
Ctrl+right to adjust the hue and Ctrl+cursor up/Ctrl+down to adjust the saturation. A status message
showing the current settings is briefly displayed in the bottom right hand corner of the display when
adjusting the hue and saturation in fullscreen photobooth mode. Setting the B&W toning hue to 200
and the saturation to 40 is a good starting point for sepia toned prints.
If the "Crop image if required to fit the printable area" checkbox is selected the image will be cropped
to fill the printable area within the grid. e.g. if the printable area within the grid is square equal portions
of the left and right of the image will be cropped to make it square.
Captions
Up to 8 captions can be added by selecting the "Edit captions..." button:
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To enable a caption select it from the "Edit:" drop down list. Then check the "Enable caption" checkbox
to enable the caption or uncheck it to disable the caption.
Each caption can occupy more than one line if required and is left justified by default. Select the
"Center justify" checkbox to center justify multiple lines. The size, font, color and rotation (in degrees
clockwise) of the caption text can also be specified. The font size is calculated using the printer
resolution and so a 72 point font should give text one inch high (one 'point' is 1/72 of an inch). The
caption is printed in the selected font color with a transparent background. Tokens can be used in the
caption text to insert values such as %d for the date and %t for the time the sequence started,
{comment} for the comments entered in the main screen and {filename} for the filename used for the
JPEG copy of the print layout. Please see the section on tokens for a list of tokens available.
Enter the position for the captions as offsets in pixels from the top and the left of the page.
The easiest way to see how this all fits together is to run PSRemote and take some test shots. First
setup the printer settings by selecting "Printer Setup..." from the File menu and then set basic
photobooth settings using the setup dialog. The take a test sequence by pressing Shift+F4 or selecting
"Photobooth Test Shot" from the File menu. This will take a sequence of images and create a test
page which is saved as photobooth_test_shot.jpg. Load this image into an image editor (or
BreezeBrowser Pro) to view the layout. Then make any changes to the background.jpg, header.jpg,
footer.jpg or overlay.png images and the photobooth settings and take more test shots until you're
happy with the layout.
Some example layouts using four shots arranged in two columns of four:
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With left.jpg down the left border, middle.jpg placed between the columns, right.jpg down the right
border and footer.jpg at the bottom
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Same layout as the first example but with no left.jpg or right.jpg images defining the left and right
borders
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Same layout as the previous example but with no middle.jpg image placed between the columns
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Same layout as the previous example but with a 2mm border around each image
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A custom layout where the size and position of each photo is specified individually

Applying effects to images before printing
You can use the editor command (File->Setup Image Editor...) to run a command or script on each
image after it has been downloaded. This could be used to run a Photoshop droplet to modify the
image. You may need to add a delay to allow time for the droplet to finish before the images are
printed. This can be done by setting the following value in the Windows registry:
HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\100
\PhotoboothDelayBeforePrintingInSecs

Images displayed to the user
If full screen mode is selected (by pressing F11 or Ctrl+F4 to enter full screen mode and display the
ready image) a series of images can be displayed to the user to show them what's happening and to
advertise the photobooth. These images are held in the same folder as the background, header and
footer images and are as follows:
ready.jpg - image displayed when PSRemote is ready to take the next set of photos
1.jpg, 2.jpg etc. - image displayed before taking the first, second, third etc. images together with the
text specified in the setting dialog
taking.jpg - image displayed for approximately 1 sec before taking each shot
release.jpg - optional image displayed when the shutter release command is sent to the camera
processing.jpg - image displayed after taking the photos while PSRemote formats and sends the page
to the printer
welcome.jpg - image displayed when standby mode has been selected by pressing F6
camera_not_connected.jpg - image displayed when the camera is turned off or disconnected
confirm_printing.jpg - optional background image when displaying print confirmation screen
printing_confirmed.jpg - optional image displayed if user selects printing from the print confirmation
screen
keyboard_input_ok.jpg - image displayed if user selects 'ok' from the on screen keyboard after the
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photos have been taken
keyboard_input_cancel.jpg - image displayed if user selects 'cancel' from the on screen keyboard after
the photos have been taken
These images can be JPEGs containing any information you like and are displayed centered on the
display with a black background. The images 1.jpg, 2.jpg etc are displayed together with the text
defined in the settings dialog which can be used to give a count down timer before each picture. The
text is displayed centered below the live viewfinder display as white text with a transparent
background. The following tokens can be used in the text:
@imageNumber@ - the number of the image in the sequence starting from 1
@numberOfImages@ - the number of images in the sequence
@secsToNextPhoto@ - the number of seconds until the next photo is taken
The images displayed to the user should be the same size or bigger than the computer's display. If the
images are too small they will be expanded to fit with a black border and a small warning message will
be displayed in the bottom left corner showing the image size and the display size.
When using live view in photobooth mode the live view images will not be updated while the camera is
actually taking each picture. This will cause the live view display to freeze for a couple of seconds and
can confuse some users as it shows the live view just before the picture is taken and this will be
slightly different from the actual photo. To avoid this problem the live view display will be blanked out
when the photo is taken if you define a release.jpg image.
It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies. This provides a way of giving
feedback to the user when different settings have been selected.
The way it works is to check for a suffix after the filename for the appropriate screen image in the form
<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <b|c|t> is
the color mode: "b" for black and white, "c" for color or "t" for monochrome toned and <1..9> is the
number of print copies e.g. "1" is one copy is selected.
For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:
ready_b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for:
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:
ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:
ready.jpg
So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1.jpg, ready_b2.jpg,
ready_b3.jpg.
When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

Using movie files to animate screens
Movie files can be displayed on the screens by placing a movie file in QuickTime MOV format in the
photobooth images folder and giving it the same name as the screen image. For example, to play a
movie when the ready.jpg screen is displayed the movie file should be named ready.mov. Movie files
can't overlap the live view display and so if live view is active the movie will be displayed in the area
below the live view.
Append "_loop" to the filename , e.g. ready_loop.mov, if you want the movie to automatically restart
from the beginning and play continuously.
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By default movie files are displayed centered on the screen unless live view is active in which case
they are displayed below the live view. Movie files can also be positioned manually by appending the
offsets from the left and top of the screen to the filename in the form _{LeftOffset}+{TopOffset} e.g. to
position the ready.mov movie 200 pixels from the left of the screen and 100 pixels from the top the file
should be named ready_200+100.mov (or ready_loop_200+100.mov if you want it to play
continuously). If the movie is larger than the screen it will be automatically scaled to fit the screen.
When a movie is displayed on the countdown screen (e.g. by naming it 1.mov) it replaces the normal
countdown text and is only played once. Approximately 1 second before the end of the movie the
taking.jpg screen is displayed and then the photo is taken when the movie reaches the end. There is a
sample movie file called countdown.mov in the folder where PSRemote is installed. To use this simply
copy it to your photobooth images folder and rename it to 1.mov, 2.mov etc.
Important: The delay before taking each photo must be set to 2 secs or more otherwise the
countdown movie will not be displayed.
Quick Time MOV files can be created using a Nikon or Canon DSLR or a video editor such as Adobe
Premiere Elements or Apple's QuickTime Pro player. Most video editors can convert video files into
different formats e.g. you can convert an AVI file to MOV format by loading the AVI video into the
editor and saving it in MOV format.
Note: Apple's QuickTime Player needs to be installed on the computer for movie playback to work.
This is a free download from Apple's website.

Audio Prompts
Audio prompts can be added by placing a WAV sound file in the photobooth images folder and giving it
the same name as prompt screen. For example to play a sound when the photobooth is ready copy a
WAV file named ready.wav into the photobooth images folder and it will be played when the ready.jpg
image is displayed. You can also play an audio file when the touchscreen keyboard is displayed by
naming it keyboard.wav and placing it in the photobooth images folder.
Note: There is no need to use a WAV file if you are already using a movie file (see above) because
movie files can contain both pictures and sound.
The easiest way to see how this works is to try it out. To do this run NKRemote then press Ctrl+F4 to
display the ready screen. Then press Shift+F4 to take a test sequence or F4 to take the pictures and
print them.
A typical 4 picture sequence would be:
At startup: "ready.jpg" image displayed on screen and "ready.wav" played once (if present)
Sequence started: "1.jpg" image displayed on screen together with countdown text and "1.wav"
played once (if present)
Approx 1 sec before taking picture #1: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #1: preview image displayed for the required number of seconds (if enabled in
the settings) then "2.jpg" image displayed on screen together with countdown text and "2.wav" played
once (if present)
Approx 1 sec before taking picture #2: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #2: preview image displayed for the required number of seconds (if enabled in
the settings) then "3.jpg" image displayed on screen together with countdown text and "3.wav" played
once (if present)
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Approx 1 sec before taking picture #3: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #3: preview image displayed for the required number of seconds (if enabled in
the settings) then "4.jpg" image displayed on screen together with countdown text and "4.wav" played
once (if present)
Approx 1 sec before taking picture #4: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #4: preview image displayed for the required number of seconds (if enabled in
the settings) then "processing.jpg" image displayed on screen and "processing.wav" played once (if
present). During this time the images are formatted ready for output and either saved to file or sent to
the printer queue. When this has finished the screen goes back to the "ready.jpg" image and the
ready.wav sound file is played ready for the next sequence.
It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies. This makes it possible to show
the user which settings have been selected and could be used as part of a touchscreen menu system.
The way it works is to check for a suffix after the filename for the appropriate screen image in the form
<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <b|c|t> is
the color mode: "b" for black and white, "c" for color or "t" for monochrome toned and <1..9> is the
number of print copies e.g. "1" is one copy is selected.
For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:
ready_b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for:
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:
ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:
ready.jpg
So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1.jpg, ready_b2.jpg,
ready_b3.jpg.
When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

Running External Commands
External commands can be used to customize the way the photobooth works e.g. by emailing images
or turning lights on and off. There are three different ways external commands can be run when
shooting in full screen photobooth mode:
1. After each photo is downloaded
2. When the photobooth screen changes during the photobooth shooting sequence
3. When the XML summary file is written after the photobooth output has been printed or saved
Running commands after downloading each photo
To do this use the edit images option and select the command line option. This could be used to run a
Photoshop droplet to modify the image. You may need to add a delay to allow time for the droplet to
finish before the images are printed. This can be done by setting the following value in the Windows
registry:
HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\100
\PhotoboothDelayBeforePrintingInSecs
Running commands when the photobooth screen changes
This allows a command to be run each time the photobooth screen changes during the photobooth
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shooting sequence. The full pathname of the screen image is passed as a command line argument to
the command e.g. C:\Program Files\BreezeSys\PSRemote\PhotoboothImages\ready.jpg. To enable
this two values need to be stored in the Windows registry: PhotoboothStatusCmdEnable and
PhotoboothStatusCmd (see below for details).
Running a command when the XML summary file is written
This allows a command to be run after the photobooth output has been saved or printed and the XML
summary file has been written. The full pathname of the XML summary file is passed as a command
line argument to the command. To enable this two values need to be stored in the Windows registry:
PhotoboothStatusCmdEnable and PhotoboothStatusCmdXML (see below for details).
Windows registry settings
To enable the photobooth screen change or XML summary file commands the following
REG_DWORD value in the Windows registry should be set to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102\PhotoboothStatusCmdEnable
The photobooth screen change command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102\PhotoboothStatusCmd
The XML summary file command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102\PhotoboothStatusCmdXML
Enter an empty string or delete the registry value for PhotoboothStatusCmd or
PhotoboothStatusCmdXML if you want to run one command but not the other. The values can be
edited using the Windows regedit utility or by creating a registry file like the one below, giving it a .reg
file extension and then double clicking on the file in Windows Explorer to copy the settings to the
registry:
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102]
"PhotoboothStatusCmdEnable"=dword:00000001
"PhotoboothStatusCmd"="C:\\Program Files\\BreezeSys\\PSRemote\\PhotoboothImages\\status.exe"
"PhotoboothStatusCmdXML"="C:\\Program Files\\BreezeSys\\PSRemote\\PhotoboothImages\\statusXML.exe"

9.4

Touchscreen Keyboard
An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. To enable the keyboard set
the photo booth start options in the photo booth settings dialog to "Touchscreen" and click on the
"Settings..." button. The touchscreen settings dialog will be displayed:
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Then select the required touchscreen keyboard option from the dropdown list:
"Not displayed" - the touchscreen keyboard is not displayed
"Display at start of sequence" - the touchscreen keyboard is displayed when the user presses the start
button before any of the photos are taken
"Display at end of sequence" - the touchscreen keyboard is displayed after the photos have been
taken and the optional print confirmation screen has been displayed (it isn't displayed if the user
chooses not to print the photos)
"Display after taking photos".- the touchscreen keyboard is displayed immediately after taking the
photos before the optional print confirmation screen
The "Timeout (secs):" setting allows an inactivity timeout to be specified. If the user does not tap the
touchscreen for a while the timeout will automatically close the touchscreen keyboard. This is useful if
the user leaves the photo booth without using the touchscreen keyboard as it allows the booth to
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automatically close the touchscreen keyboard and display the ready screen ready for the next user.
The touchscreen keyboard can be tested by pressing the "Test keyboard..." button. The default
keyboard layout will fill the screen and look similar to the screenshot below:

The keyboard used for entering Facebook login information can be displayed by holding down the
control key when clicking on the "Test keyboard..." button. Alternatively the keyboard used for entering
the user's email address when using the email option can be displayed by holding down the shift key
when clicking on the "Test keyboard..." button.
The text entered by the user is saved in the <user_data> tag (and the <user_data2> tag if two text
fields are defined) in the XML file written at the end of the photo booth shooting sequence. If any
checkboxes are defined (see below) their status will be saved in <chkbox1>, <chkbox2> etc. tags e.g.
if the user selects the first checkbox the XML will contain <chkbox1>1</chkbox1>. The XML file is
saved in the same folder as the photos downloaded from the camera (see preferences) e.g.
<?xml version="1.0" ?>
<breeze_systems_photobooth version="1.0">
<photo_information>
<date>2011/01/26</date>
<time>16:37:19</time>
<user_data>sales@breezesys.com</user_data>
<photobooth_images_folder>C:\Photobooth\PhotoboothImages</photobooth_images_folder>
<photos>
<photo image="1">20110126_163719_1.JPG</photo>
<photo image="2">20110126_163719_2.JPG</photo>
<photo image="3">20110126_163719_3.JPG</photo>
<photo image="4">20110126_163719_4.JPG</photo>
<output>prints\20110126_163719.jpg</output>
</photos>
</photo_information>
</breeze_systems_photobooth>

There is a default timeout of 300 secs after which time the touchscreen keyboard will be automatically
canceled. This timeout is stored in the Windows registry key:
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HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102\PhotoboothKeyboardTimeout

Note for Windows 8 touchscreen usage
On Windows 8 flicking the corners of the screen will display Windows system options which will allow
users to break out of the photobooth application. This can be preventing by using a free utility such as
Skip Metro Suite which can be downloaded from:
http://winaero.com/comment.php?comment.news.103

Customizing the keyboard
The layout of the keyboard can be customized by creating an XML settings file called keyboard.xml
and putting this in the photo booth images folder. This gives control over the size and position of the
keys, the background color etc. A series of keyboard images can also be used if you need more
control of the appearance of the keyboard.
The easiest way to customize the keyboard is to save a copy of the XML file and TIFF screen images
used to define the default keyboard layout and then edit them as required. The files can be saved by
first displaying the keyboard by pressing the "Test keyboard..." button and then holding down both the
Shift and Ctrl keys and pressing the left mouse button. The keyboard.xml file will look something like:
<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.2">
<photobooth_settings>
<keyboard>
<text_point_size>480</text_point_size>
<prompt1>Please enter your email address:</prompt1>
<text1_y>411</text1_y>
<text1_x>50</text1_x>
<text1_r>300</text1_r>
<background_color>0x000080</background_color>
<transparent_color>0x000080</transparent_color>
<text_color>0xFFFFFF</text_color>
<show_cursor>0</show_cursor>
<show_mouse_cursor>0</show_mouse_cursor>
<key>
<left>58</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>q</legend>
<shifted_legend>Q</shifted_legend>
<code>q</code>
<shifted_code>Q</shifted_code>
</key>
<key>
<left>186</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>w</legend>
<shifted_legend>W</shifted_legend>
<code>w</code>
</key>
...
<key>
<left>1296</left>
<top>840</top>
<width>160</width>
<height>89</height>
<legend>Shift</legend>
<shifted_legend>Shift</shifted_legend>
<code>Shift</code>
<shifted_code>Shift</shifted_code>
</key>
<key>
<left>400</left>
<top>945</top>
<width>368</width>
<height>89</height>
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<legend>Send email</legend>
<shifted_legend>Send email</shifted_legend>
<code>OK</code>
<shifted_code>OK</shifted_code>
</key>
<key>
<left>784</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>No thanks!</legend>
<shifted_legend>No thanks!</shifted_legend>
<code>Cancel</code>
<shifted_code>Cancel</shifted_code>
</key>
</keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

The <prompt1> tag defines the text that is displayed above the user input area and defaults to "Please
enter your email address:". The <text1_x> and <text1_y> tags specify the position of the user input
area. This is specified as the number of pixels down from the top, left corner of the screen. The right
hand side of the user input area can be specified using the <text1_r> tag.
Additional prompts can be added by including <prompt2>, <text2_x>, <text2_y>, <text2_r> etc. tags up
to a maximum of 10 user input areas.
The prompt tags can have an optional password attribute which if set to "1" will display the text in the
user input area as * characters e.g. <prompt1 password="1">Please enter your password:</prompt1>.
The prompt tags can have an optional mandatory attribute which if set to "1" means that the prompt
must contain text e.g. <prompt1 mandatory="1">Please enter your name:</prompt1>.
The prompt tags can have an optional email_address attribute which if set to "1" will check that the text
looks like an email address in the form name@domain.com e.g. <prompt1 email_address="1">Please
enter your email address:</prompt1>. If the text does not appear to be an email address an error
message saying "Please enter a valid email address in the form name@domain.com" will be
displayed. The text of this error message can be changed in the email settings dialog.
The input text area is normally on a single line. Multiple lines can be used by setting the prompt tag's
rows attribute to 2 or more e.g. <prompt1 rows="3">Please enter a message:</prompt1>.
When more than one user input area is defined users can switch between the input areas by touching
them. The currently selected input area is highlighted in red.
The optional <text_point_size> tag defines the size of the text font used in the user input area. This is
specified in tenths of a point and defaults to 480 (a point size of 48).
The text entered by the user is stored in the <user_data>, <user2_data> etc. fields in the XML file
saved with the photos.
Up to 10 checkboxes can be added using the <chkbox1_prompt>, <chkbox1_x>, <chkbox1_y>,
<chkbox2_prompt>, <chkbox2_x>, <chkbox2_y> etc. tags. The <chkbox1_prompt> tag specifies the
text displayed to the right of the text box and can include a value attribute to specify whether the
checkbox is initially checked or not e.g. <chkbox1_prompt value="0">Checkbox prompt (default off)</
chkbox1_prompt> or <chkbox1_prompt value="1">Checkbox prompt (default on)</chkbox1_prompt>.
A checkbox can also be made mandatory (i.e. the user has to check the checkbox before pressing the
"OK" button) by adding the mandatory attribute to the <chkbox1_prompt> tag e.g. <chkbox1_prompt
mandatory="1">I agree to the terms and conditions</chkbox1_prompt>.
The <chkbox1_x> and <chkbox2_y> tags specify the position of the checkbox.
The checkbox status is stored in the <chkbox1>, <chkbox2> etc. fields in the XML file saved with the
photos.
The <background_color> tag specifies the background color of the window and the <key_text_color>
specifies the color for the prompt text and key legends.
The optional <text_foreground_color> tag specifies the foreground color for text displayed in the user
input areas. The default value if this tag is omitted is black (0x000000).
The optional <text_background_color> tag specifies the background color for the user input areas. The
default value if this tag is omitted is white (0xFFFFFF).
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The optional <transparent_color> tag specifies a color which will be made transparent when the
keyboard is displayed.
All colors should be hexadecimal RGB values e.g. 0x000000 for black, 0xFF0000 for red, 0x00FF00
for green, 0x0000FF for blue, 0xFFFFFF for white.
The <show_cursor> tag specifies whether a gray cursor is shown in the user input area. Set this to 1 to
display the cursor or 0 to hide it. The cursor display is useful if the keyboard allows the entry of spaces.
The <show_mouse_cursor> tag specifies whether a the mouse cursor is displayed, The default setting
is for the mouse cursor not to be displayed.
The <key> tag specifies the size and position of each key, its legends and what should be typed when
it is pressed. The top left corner of the key is defined using the <left> and <top> tags and the width and
height are specified using the <width> and <height> tags (all values are in pixels). The
<shifted_legend> tag specifies what is displayed on the key when the shift key is pressed and the
<legend> specifies the key legend when shift is not pressed.
The <shifted_code> tag specifies what is typed when the key is pressed when shift is pressed and the
<code> tag specifies what is typed when the shift key is not pressed. The following codes have special
values:
"Shift" - puts the keyboard into shifted mode (i.e. upper case) when pressed
"OK" - closes the keyboard window and returns the user input if at least one text input field contains
text
"OK all" - closes the keyboard window and returns the user input if all the input fields contain some text
"OK none" - closes the keyboard window and returns the user input even if none of the input fields
contain text
"Cancel" - closes the keyboard window and cancels the user input
International and special characters need to be added in UTF-8 unicode format e.g. the Euro symbol,
€, is defined in UTF-8 as 0x20AC. This needs to added to the XML file as &#x20ac; e.g.
<key>
<left>58</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>&#&x20ac;</legend>
<shifted_legend>&#&x20ac;</shifted_legend>
<code>&#&x20ac;</code>
<shifted_code>&#&x20ac;</shifted_code>
</key>

The keyboard.xml can just include additional settings and the touchscreen keyboard will use the default layout (show
<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.3">
<photobooth_settings>
<keyboard>
<chkbox1_prompt value="0">I agree to my photos being posted on a web site</chkbox1_prompt>
<chkbox1_x>38</chkbox1_x>
<chkbox1_y>70</chkbox1_y>
</keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Keyboard images
Separate keyboard screen images can be defined if you need more control over the appearance of the
keyboard. These images should be TIFF images the same size as the resolution of the screen and
should be placed in the photo booth images folder. The keyboard images should be named as follows:
keyboard_uppercase.tif - keyboard image showing upper case key legends
keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed
keyboard_lowercase.tif - keyboard image showing lower case key legends
keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
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pressed
If TIFF keyboard images aren't found the software will attempt to load JPEG images instead
(keyboard_uppercase.jpg, keyboard_uppercase_pressed.jpg, keyboard_lowercase.jpg and
keyboard_lowercase_pressed.jpg).
When the email option is used (see Uploading to social networks...) the touchscreen keyboard will look
for the following keyboard xml definition file and keyboard images:
email_keyboard.xml - XML file defining the keyboard layout
email_keyboard_uppercase.tif - keyboard image showing upper case key legends
email_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
email_keyboard_lowercase.tif - keyboard image showing lower case key legends
email_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed
Please note that for compatibility with previous releases the email option will use the standard XML
definition file and keyboard images if versions with an email_ prefix aren't found.
When the Facebook upload option is used (see Uploading to social networks...) the touchscreen
keyboard will look for the following keyboard xml definition file and keyboard images:
fb_keyboard.xml - XML file defining the keyboard layout
fb_keyboard_uppercase.tif - keyboard image showing upper case key legends
fb_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed
fb_keyboard_lowercase.tif - keyboard image showing lower case key legends
fb_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed
Please take care that the keys are in the same positions in each of the keyboard images and that
these also correspond to the values in the keyboard.xml file. The <background_color>, <text_color>,
<prompt>, <legend> and <shifted_legend> tags in the keyboard.xml file are ignored when keyboard
images are used to define the appearance of the keyboard.
Note: If you only need to change the keyboard layout and are happy with the default keyboard display
you only need to create a keyboard.xml file in the photo booth images folder and can delete the
keyboard screen images (keyboard_uppercase.tif, keyboard_uppercase_pressed.tif,
keyboard_lowercase.tif and keyboard_lowercase_pressed.tif). If keyboard images are defined the
<prompt> tags in the keyboard.xml file will be ignored.

9.5

Animated GIFs
Animated GIFs provide a way of displaying a short sequence of images that are displayed in a
continuous loop. DSLR Remote Pro has two options for creating animated GIFs:
1. As a simple slideshow showing the photos taken during the shooting sequence with an optional
overlay and title page
2. As a short video clip captured in video booth mode. Please note that the animated GIF don't
include sound
The animated GIFs can be viewed using our Breeze Kiosk software and then shared by email, text
(MMS in USA and Canada, SMS elsewhere) or uploaded to Facebook and Twitter.
A MP4 movie file can also be created from the animated GIFs.

Creating Animated GIFs in Photo Booth Mode
Select "Create animated GIF of photos" on the "Output Settings" dialog and then click on the
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"Animated GIF settings..." button to configure the settings:

The animated GIFs will show the photos in the same orientation as the live view display. If the live view
display is cropped or digitally zoomed the photos added to the animated GIF will be cropped and
zoomed by the same amounts.
If green screening is enabled the green screened copy of the photos will be added to the GIF. The the
transparent background option is selected in the green screen settings the photo placed in the GIF will
also have a transparent background.
If B&W mode, monochrome toning (e.g. sepia) or creative filters are used the photos will be added to
the animated GIF with these effects applied.
Use the "Photo width (pixels):" setting to specify the width photos added to the animated GIF. The
height of the photos will be calculated automatically in proportion to the width e.g. setting the width to
600 pixels will give a height of 400 pixels when the camera is horizontal or a height of 900 pixels if the
camera in in portrait orientation.
The "Photo left offset:" and "Photo top offset:" settings specify the position the photos are added to the
GIF. The offsets are measured in pixels from the left and top edges of the GIF.
The "GIF width" and "GIF height" settings specify the size of the animated GIF in pixels. If these
settings are 0 the GIF will created the same size as the photos.
An optional overlay can be displayed over each photo by placing a PNG file named GIF_overlay.png in
the photo booth images folder. A different overlay can be used for each photo by naming the overlays
GIF_overlay_1.png for photo 1, GIF_overlay_2.png for photo 2 etc.
An optional background can also be used for each photo by placing a JPEG image named
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GIF_background.jpg in the photo booth images folder. A different background can be used for each
photo by naming it GIF_background_1.jpg, GIF_background_2.jpg etc.
Background images can be used as a simple way to provide a background to the GIF when the GIF is
larger than the photo.
Multiple overlays (and/or backgrounds can be added to each photo by setting "Backgrounds/overlays
per photo" to more than 1 e.g. to display two overlays per photo set "Overlays per photo" to 2 and
name the files as follows: GIF_overlay_1.png for the first half of photo 1's display time, GIF_overlay_2.
png for the second half of photo 1's display time, GIF_overlay_3.png for the first half of photo 2's
display time, GIF_overlay_4.png for the second half of photo 2's display time etc.
The PNG overlay images can be made transparent or semi-transparent by adding an alpha channel.
If overlay images are larger than the GIF width setting they will be resized to the same width. If an
overlay is smaller than the GIF it will be displayed bottom right justified i.e. in the bottom right hand
corner.
The image interval setting specifies how long each photo should be displayed and is in units of 1/100
sec. A value of 75 (3/4 sec) to 100 (1 sec) is probably a good starting point.
One or more optional title pages can be displayed at the beginning or end of the photo sequence. To
add a single title page place a JPEG image named GIF_title.jpg in the photo booth images folder. To
add multiple title pages to create a short animation place JPEG images named GIF_title_1.jpg,
GIF_title_2.jpg, GIF_title_3.jpg etc. in the photo booth images folder
If the title page image is larger than the GIF width setting it will be resized to the same width. Use the
"Title display time" to specify how long each title page should be displayed.
The title page or pages can be displayed before or after the photos. It probably makes more sense to
display titles after the photos because browsers that display animated GIFs will normally show a
thumbnail generated from the start of the animation. Putting the title at the end will mean that the
thumbnail will show the first photo whereas if the title is at the start of the animation the thumbnail will
show the title page.
Select "Play GIF in a continuous loop" if you want the GIF to loop indefinitely. If this option is not
selected the GIF will loop once i.e. it will play the animation twice by running through it once and then
looping a single time to play it again.
Select the "Ping-pong" option to play the photo sequence forwards and then backwards e.g.
4 photos with no title and the ping-pong option selected will display photo 1, photo 2, photo 3, photo 4,
photo 3, photo 2, photo 1, photo 2 etc.
4 photos with no title and the ping-pong option not selected will display photo 1, photo 2, photo 3,
photo 4, photo 1, photo 2, photo 3, photo 4 etc.
4 photos with a title at the end and the ping-pong option selected will display photo 1, photo 2, photo 3,
photo 4, photo 3, photo 2, photo 1, title, photo 1, photo 2 etc.
When using overlays with the "ping-pong" option the overlay files should be named as follows:
Overlay files for 3 photos with no title, the ping-pong option selected and overlays per photo set to 1:
GIF_overlay_1.png for photo 1, GIF_overlay_2.png for photo 2, GIF_overlay_3.png for photo 3,
GIF_overlay_4.png for photo 2
Overlay files for 3 photos with a title, the ping-pong option selected and overlays per photo set to 2:
GIF_overlay_1.png/GIF_overlay_2.png for photo 1, GIF_overlay_3.png/GIF_overlay_4.png for photo 2,
GIF_overlay_5.png/GIF_overlay_6.png for photo 3, GIF_overlay_7.png/GIF_overlay_8.png for photo 2,
GIF_overlay_9.png/GIF_overlay_10.png for photo 1
Select the "Create PNG copies of GIF frames in 'GIF_frames' subfolder" option to create PNG copies
of all the frames that make up the animated GIF. This is useful if the frames are to be processed by
other software.
Please note: It is not necessary to select this option to create MP4 copies of the GIFs.

© 2016 Breeze Systems Ltd

76

PSRemote

Warning: The PNG files created when this option is selected can be quite large and may fill up the
computer's hard disk.
By default the animated GIF will be created in a subfolder named GIF in the download folder. If you
are using our Breeze Kiosk software to display the animated GIFs you need to set it up to monitor the
GIF folder.
Select the "Save GIF in 'prints' subfolder" option to save the GIF in the prints subfolder with the JPEG
copies of the printed output. This is useful if you are using kiosk software and wish to display the GIFs
and the prints.
Select the "Create MP4 copy of the animated GIF" option to automatically create an MP4 movie file of
the animated GIF. Set the minimum duration of the movie in secs or set this to 0 to make the movie as
short as possible. This option is useful if the movie file is to be uploaded to a site which has a minimum
length requirement (e.g. videos posted to Instagram must be at least 3 seconds long). If the movie file
will be shorter than the minimum length the GIF frames, but not the title frames, will be repeated until
the movie is long enough.
Use the "Save MP4 in" checkbox to specify where the MP4 files should be saved:
"same folder as GIF" will save the MP4 file in the same folder as the GIF (either the GIFs subfolder or
the prints subfolder depending on the "Save GIF in 'prints' subfolder" setting)
"'MP4' subfolder" will save the MP4 file in a subfolder named MP4
"prints' subfolder" will save the MP4 file the prints subfolder (where the JPEG copies of the prints are
also saved)
Please note: The output setting must be set to "Print only", "Print and save JPEG copy" or "JPEG
copy only" in order to create the animated GIF. The GIF will not be created if the output is set to
"None". You also need to create a print layout which includes all the photos taken otherwise an error
will be displayed when the software tries to create the animated GIF.

Dithered vs Indexed Color
Animated GIFs can only display 256 different colors per frame which causes a problem when trying to
display photos which typically have many more colors. There are two ways to handle this limitation:
1) Dithered color where the color of each pixel is represented by several pixels
2) Indexed color where the 256 most common colors in the photo are used
Dithered images can give a better representation of the colors in the original photo but will provide less
detail for a given image size. Indexed colors give better detail and usually give adequate colors but
may show some contouring or shimmering with some photos, particularly if there are areas of
graduated color in the original photo.
Indexed color is recommended for most applications for animated GIFs and so the "Dither GIFs to give
better color" option should normally be left unchecked.

9.6

Keyboard Shortcuts
The photobooth mode in PSRemote can accept the following key presses:
F2 - switch to B&W mode and start the photobooth sequence
F3 - switch to color mode and start the photobooth sequence
F4 - start the photobooth sequence using the current B&W or color setting
F5 - same as F4
F6 - toggle standby mode
Ctrl+Alt+F6 - switch from standby to ready mode
F8 - take a photo
F9 - take a preview photo
Ctrl+B - switch to B&W mode but don't start the photobooth sequence
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Ctrl+C - switch to color mode but don't start the photobooth sequence
Ctrl+K - switch to color mode but don't start the photobooth sequence (alternative for Ctrl+C)
Ctrl+R - reprint the last set of photos without displaying the touchscreen keyboard or print confirmation
screens
Ctrl+Alt+R - reprint the last set of photos with touchscreen keyboard and print confirmation screens if
enabled
Shift+Ctrl+R - fast reprint of the last set of photos (if output option is set to "Print and save JPEG
copy")
Ctrl+T - switch to tinted B&W
Ctrl+W - toggle between B&W and color modes
A - Accept print when print confirmation window is displayed
W - cycle through color, B&W and B&W (toned) modes
X - Reject print when print confirmation window is displayed
Ctrl+1 - select one copy of prints
Ctrl+2 - select two copies of prints
Ctrl+3 - select three copies of prints
Ctrl+4 - select four copies of prints
Ctrl+5 - select five copies of prints
Ctrl+6 - select six copies of prints
Ctrl+7 - select seven copies of prints
Ctrl+8 - select eight copies of prints
Ctrl+9 - select nine copies of prints
Shift+CursorLeft - crop live view display (reduce the amount of cropping)
Shift+CursorRight - crop live view display (increase the amount of cropping)
Ctrl+Alt+1 - select profile 1 and start shooting sequence
Ctrl+Alt+2 - select profile 2 and start shooting sequence
Ctrl+Alt+3 - select profile 3 and start shooting sequence
Ctrl+Alt+4 - select profile 4 and start shooting sequence
Ctrl+Alt+5 - select profile 5 and start shooting sequence
Ctrl+Alt+6 - select profile 6 and start shooting sequence
Ctrl+Alt+7 - select profile 7 and start shooting sequence
Ctrl+Alt+8 - select profile 8 and start shooting sequence
Shift+Ctrl+1 - select profile 1
Shift+Ctrl+2 - select profile 2
Shift+Ctrl+3 - select profile 3
Shift+Ctrl+4 - select profile 4
Shift+Ctrl+5 - select profile 5
Shift+Ctrl+6 - select profile 6
Shift+Ctrl+7 - select profile 7
Shift+Ctrl+8 - select profile 8
Shift+Ctrl+9 - select profile 9
Shift+Ctrl+F1 - select profile 10
Shift+Ctrl+F2 - select profile 11
Shift+Ctrl+F3 - select profile 12
Shift+Ctrl+F4 - select profile 13
Shift+Ctrl+F5 - select profile 14
Shift+Ctrl+F6 - select profile 15
Shift+Ctrl+F7 - select profile 16
Shift+Ctrl+F8 - select profile 17
Shift+Ctrl+F9 - select profile 18
Shift+Ctrl+N - select next profile
Shift+Ctrl+P - select previous profile
CursorUp - zoom in
CursorDown - zoom out
Ctrl+CursorLeft/CursorRight - adjust the hue of the tint applied to monochrome images when the tinted
option is selected
Ctrl+CursorUp/CursorDown - adjust the saturation of the tint applied to monochrome images when the
tinted option is selected
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Number pad '+' - increase the number copies of prints (up to a maximum of 9 copies)
Number pad '-' - decrease the number copies of prints (down to a minimum of 1 copy)

9.7

Using External Buttons for Photobooth Shooting
This page describes a number of different options for connecting one or more pushbuttons to a PC
and use them to control the photobooth mode shooting mode.
Note: For a simple setup you can use the PC's mouse to control the photobooth by selecting the "Use
mouse left button to start and right button to toggle between B&W and color" option in the photobooth
settings.
The photobooth mode in PSRemote can accept the following key presses:
F2 - switch to B&W mode and start the photobooth sequence
F3 - switch to color mode and start the photobooth sequence
F4 - start the photobooth sequence using the current B&W or color setting
F5 - same as F4
F8 - take a photo
F9 - take a preview photo
Ctrl+B - switch to B&W mode but don't start the photobooth sequence
Ctrl+C - switch to color mode but don't start the photobooth sequence
Ctrl+K - switch to color mode but don't start the photobooth sequence (alternative for Ctrl+C)
Ctrl+R - reprint the last set of photos
Ctrl+1 - select one copy of prints
Ctrl+2 - select two copies of prints
Ctrl+3 - select three copies of prints
Ctrl+4 - select four copies of prints
Ctrl+5 - select five copies of prints
Ctrl+6 - select six copies of prints
Ctrl+7 - select seven copies of prints
Ctrl+8 - select eight copies of prints
Ctrl+9 - select nine copies of prints
Shift+Ctrl+1 - select profile 1
Shift+Ctrl+2 - select profile 2
Shift+Ctrl+3 - select profile 3
Shift+Ctrl+4 - select profile 4
Shift+Ctrl+5 - select profile 5
Shift+Ctrl+6 - select profile 6
CursorUp - zoom in
CursorDown - zoom out
Number pad '+' - increase the number copies of prints (up to a maximum of 9 copies)
Number pad '-' - decrease the number copies of prints (down to a minimum of 1 copy)
This means you could have a single button setup which always takes photos in B&W or color
depending on the photobooth settings in PSRemote or have two buttons and let the user decide
whether they would like B&W or color photos.

StealthSwitch
The StealthSwitch is a robust foot switch which plugs straight into a USB port and makes an ideal
switch for photobooth operation. It is very simple to use: just plug it in to any spare USB port, wait a
few seconds for Windows to recognize it and you're ready to go. In full screen photobooth mode
pressing the StealthSwitch button will start the photobooth sequence - that's all there is to it.
Note: If you have already installed the "desktop cloaking" software that comes with the StealthSwitch
© 2016 Breeze Systems Ltd

Photobooth Shooting

79

you need to disable it otherwise every time you press the button the photobooth display will be hidden.

Arcade Style Buttons
There are several ways arcade style buttons can be connected to a PC and used to control the
photobooth including the StealthSwitch 3 and the serial port method. The StealthSwitch 3 is simpler to
setup than the serial port method but is a little more expensive. Both the StealthSwitch 3 and the serial
port methods are described in detail below.

StealthSwitch 3
The StealthSwitch 3 is similar to the original StealthSwitch described above but has two important
differences:
1) You can connect external buttons which simply plug into standard 3.5mm sockets (the same as
used by most MP3 players)
2) Each button is programmable allowing it to send any key press or sequence of key presses you like
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StealthSwitch 3 showing the five 3.5mm sockets for connecting external buttons on the front and the
USB port on the side
Please note: The StealthSwitch 3 is functionally identical to the StealthSwitch II which it replaces.
Instructions to add an arcade style button using the StealthSwitch 3:
These are the components required to add an arcade style button: the button, stereo cable with 3.5mm
jacks and two female spade connectors

1) Cut off the jack plug from one end of the stereo cable and bare the wires
2) Plug the USB cable from the StealthSwitch II and plug the remaining 3.5mm jack from the stereo
cable into one of the StealthSwitch sockets
3) Run StealthSwitch Configuration Utility and select "Keyboard test mode". When you press the each
button you should see something like this:
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4) Release the switch and identify the correct wires to use from the stereo cable by shorting two of
them together. When the correct pair of wires are shorted together the keyboard test window will show
A, B, C, D or E
5) Attach the spade connectors to each of the two wires identified in step 4. Use a crimp tool or solder
them to ensure they are firmly attached
6) Connect the wire to the arcade switch using the spade connectors and press the button to check
that the keyboard test window shows A, B, C, D or E
You should now have an arcade button attached to a cable with a 3.5mm jack plug which looks
something like this:

Finally use the StealthSwitch Configuration Utility to program each of the buttons to send the required
key strokes. The best way to do this is to right click on the required button in the main Configurator
window and select "Macro 1", click on "1st KEY" and type the first key in the macro e.g. function key
F4 to start the photobooth sequence. If the macro has more than one key, e.g. Ctrl+B to select black
and white mode, click on "1st KEY" and press (and release) the Ctrl key then click on "2nd KEY" and
press C. When you've finished press the Program button to program the StealthSwitch 3 (you only
need to do this once - the StealthSwitch 3 will remember the settings and can be used on any
computer). The StealthSwitch 3 is now ready to be used to control the photobooth.

Serial Port Method
What you need
1. Unless the PC has a serial port you will need a USB to RS-232 adaptor such as the StarTech.com
USB to RS-232 Serial DB9 Adaptor. This is not the cheapest adaptor available, but it does work on
Windows XP and Windows Vista.
2. DB9 socket and wires or an old RS-232 cable with a DB9 socket
3. A suitable "push to make" button. The arcade style button below was purchased from Gremlin

© 2016 Breeze Systems Ltd

82

PSRemote

Solutions in the UK. This site in the US has a good selection of buttons: www.happcontrols.com
4. Photobooth Pushbutton Utility, PhotoboothBtn.exe, which can be found in the PSRemote installation
folder

Connecting it up
First install the driver software that comes with the USB to serial to RS-232 adaptor and connect it to a
USB port on your PC. Then run the Photobooth Pushbutton utility:
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Next identify the correct COM port for the serial port. This can be done by using a small piece of wire
and connecting pins 1 and 4 on the DB9 connector (shown below). If the correct COM port is selected
the "Pin 1" checkbox in the Photobooth Pushbutton utility should be checked when pins 1 and 4 are
connected. If nothing happens try selecting a different COM port from the drop down list.

Now wire up the button or buttons to the appropriate pins on the DB9 socket e.g. if you're using two
buttons pin 4 should be connected to the "common" connections of the two buttons and pin 1 should
be connected to the "push to make" connection of one button and pin 6 to the "push to make"
connection of the other button. Normally the connections would be made by soldering the wires to the
DB9 connector but if you're not happy with soldering you can use an RS-232 cable instead and simply
cut off one end, identify which wires to use and then connect them to the spade connections on the
buttons using crimp connectors.
Once the buttons are connected they can be tested by observing whether the appropriate checkboxes
are checked in the pushbutton utility app when each button is pressed.
Finally, select the required action for each button using the drop down lists in the pushbutton utility e.g.
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for a two button setup with PSRemote where the user can select B&W or color prints you would use
settings similar to those below:

In operation
Connect the USB to RS-232 adaptor to a USB port on the PC and, making sure no buttons are
pressed, run the Photobooth Pushbutton utility. Before running PSRemote check that the buttons are
working properly by pressing them and making sure the correct checkbox in the pushbutton utility is
checked. It may be necessary to select a different COM port if the buttons don't work. Normally the
same COM port is assigned provided the USB to RS-232 adaptor is connected to the same USB port
each time.
Next run PSRemote, select fullscreen photobooth mode and you should be able to use the buttons to
trigger the photobooth sequence. The Photobooth Button utility needs to running at all times during
photobooth operation so that it can detect the button presses and forward them to PSRemote.

9.8

In Operation
In Operation
Once everything is setup simply run PSRemote and press Ctrl+F4 to enter full screen mode and
display the ready screen. You probably don't want to have a keyboard on show otherwise users will be
able to exit the photobooth mode and access your computer. There are a number of methods that can
be used to start the photobooth shooting sequence:
1. The simplest option is to use a mouse and set the start option to "Left click to start, right click to
toggle B&W mode" or one of the other left click options. Provided the keyboard is hidden away the
users won't be able to access your computer but use the left mouse button to start the sequence
and the right mouse button to toggle between B&W and color photos.
2. Alternatively you could use a programmable USB input device which can be setup to send an F4
key press to PSRemote:
a) The Powermate from Griffin Technology (http://www.griffintechnology.com/products/powermate/)
is an inexpensive and nicely made device which works very well.
b) The StealthSwitch (http://www.stealthswitch.com) is a very robust foot switch which simply needs
to be plugged in to be used in fullscreen photobooth mode. No additional drivers need to be
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installed. The desktop hiding software that comes with the StealthSwitch should be disabled
otherwise the photobooth screen will be hidden when the switch is pressed.
3. For a more professional setup you could use external panel mounted buttons.
4. Use a touchscreen and one of the left click start options
If "auto reconnect" is selected from the "Camera" menu the camera can be turned off when not in use
and then turned it back on again to automatically restart photobooth operation. When the camera is
turned off the camera_not_connected.jpg screen is displayed and when it is turned back on again the
ready.jpg screen is displayed.
The keyboard shortcuts Ctrl+1, Ctrl+2, Ctrl+3, Ctrl+4, Ctrl+5, Ctrl+6, Ctrl+7, Ctrl+8 or Ctrl+9 can be
used to specify the number of copies of prints when running in full screen photobooth mode. The
number pad "add" and "subtract" keys can also be used to increase or decrease the number of copies.
A small confirmation message is displayed for approximately 2 seconds in the bottom right corner of
the display when the number of copies is changed.
A default profile can be used to reset the photobooth to a known state after each shooting sequence.
To exit fullscreen photobooth mode either press the Esc key or hold down the SHIFT key and press
the left mouse button.

Reprints
The last print layout can be reprinted by typing Ctrl+R in full screen photobooth mode. Alternatively
select the output option to also save a JPEG copy and then use a browser or image editor to select
and print the required layout.

Reprinting after an Event
If the output option was set to "Print and save JPEG copy" or "JPEG copy only" when the photos were
taken a JPEG copy of the printed output will be saved in the prints subfolder. The JPEG copies of the
printed output can be reprinted after an event by selecting "Print selected photobooth photos..." from
the File menu and then selecting one or more JPEGs for printing.
If a JPEG copy of the printed output is not available or you want to reprint the photos using a different
layout you can do it as follows:
1. Setup the printer and photobooth print layout as required
2. Use Windows Explorer to drag and drop the first set of photos into the PSRemote main window
3. Type Shift+Ctrl+R or select "Reprint photos" from the File menu and the photos will be printed
4. Repeat steps 2 and 3 to as required

XML Shooting Information
After each set of shots an XML file containing information about the set of photos is written to the
folder where the photos are downloaded from the camera. The XML file has the same filename as the
first shot in the sequence (but with a .XML file extension). An example XML shooting information file is
shown below:
<?xml version="1.0" ?>
<breeze_systems_photobooth version="1.1">
<photo_information>
<date>2011/01/26</date>
<time>16:37:19</time>
<user_data>sales@breezesys.com</user_data>
<photobooth_images_folder>C:\Photobooth\PhotoboothImages</photobooth_images_folder>
<caption1>First caption</caption1>
<caption2>Second caption</caption2>
<photos>
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<photo image="1">20110126_163719_1.JPG</photo>
<photo image="2">20110126_163719_2.JPG</photo>
<photo image="3">20110126_163719_3.JPG</photo>
<photo image="4">20110126_163719_4.JPG</photo>
<output>prints\20110126_163719.jpg</output>
</photos>
</photo_information>
</breeze_systems_photobooth>

The <date> and <time> tags contain the date and time of the first shot in the sequence. Please note
that the date and time will only be correct if the camera's clock is set correctly.
The <user_data> tag contains the text entered by the user if the touchscreen keyboard option is used.
The <photobooth_images_folder> contains the full pathname of the photo booth images folder.
The <caption1> and <caption2> tags contain the text used for the captions printed on the photos or
empty strings if these are not defined.
The <photo> tags contain the filenames of the photos taken in the shooting sequence.
The <output> tag contains the filename of the JPEG copy of the printed output (if selected).
The writing of the XML shooting information file can be suppressed by setting the following value in the
Windows registry to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102\PhotoboothSuppressXml
This can be done by creating a text file named SuppressXML.reg containing the following and then
double clicking on the file in Windows Explorer to copy the information to the registry:
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\BreezeSystems\PSRemote\102]
"PhotoboothSuppressXml"=dword:00000001

Please note that this setting will be ignored and the XML will be written if the touchscreen keyboard
option is used.

9.9

Green Screen Shooting
The photobooth mode in PSRemote v2.0 introduces green screen shooting. Green screen
photography works by taking photos of the subject in front of a green background and then
automatically replacing the background with a background image. The background image can be
anything you like such as an exotic location, a cityscape or even a photo of the President of the United
States.
PSRemote also supports blue screen shooting. This works in exactly the same way but uses a blue
background instead of a green background. To enable blue screen shooting select the "Blue screen
mode" checkbox when the green screen settings dialog is displayed.
PSRemote will automatically replace the green background with the chosen background when using
live view in photobooth mode. This means that the users will see what the final picture will look like
with the new background as opposed to the green background that the cameras sees.
A basic green screen setup is shown below:
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Basic green screen setup with green screened live view images displayed on the monitor

When the images are printed out as a double strip they look like this:

Please note: The greenscreening is optimized for speed not quality in order to be able to display the
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greenscreened images in the live view window in realtime. The quality should be good enough for
small photos and prints, but if you want large high quality results you may need to use specialist green
screen software such as FxHome PhotoKey.

Greenscreen settings
To display the green screen settings in photobooth mode first connect a camera and then select full
screen photobooth mode. Then type Ctrl+G to display the green screen settings:

Adjust the sliders so that all of the green screen background is replaced with the background image
but the foreground subject is unaffected. The easiest way to do this is to move the "Green threshold"
slider to the left until most of the background is replaced and then fine tune the settings by moving the
"Red level" and "Blue level" sliders to the right. The best settings to use will depend on the lighting
conditions and the quality of the green background. If areas of the subject show the background the
settings are too strong and should be reduced by moving the red and blue sliders to the left of the
green slider to the right.
For best results the avoid green background should be evenly lit and the subject should be positioned
to minimize shadows falling on the background.
Select the "Save copy of greenscreened photos in photo booth mode" option to save a of the photo
downloaded from the camera with the green background replaced with the background image. The
greenscreened copies are saved the "greenscreen" subfolder of the folder where the images from the
camera are saved.

Green Screen Backgrounds and Overlays
In fullscreen photobooth mode the green screen background and overlay images are loaded from the
photobooth images folder. The background image should be named greenscreen_background.jpg and
the overlay image should be named greenscreen_overlay.png. Different overlays and backgrounds
can be used for each shot by appending the shot number to the filenames e.g.
Shot 1: background filename: greenscreen_background_1.jpg, overlay filename:
greenscreen_overlay_1.png
Shot 2: background filename: greenscreen_background_2.jpg, overlay filename:
greenscreen_overlay_2.png
Shot 3: background filename: greenscreen_background_3.jpg, overlay filename:
greenscreen_overlay_3.png
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Shot 4: background filename: greenscreen_background_4.jpg, overlay filename:
greenscreen_overlay_4.png
Backgrounds and overlays can also be switched by saving a number of different profiles each using a
different photo booth images folder containing different greenscreen_background.jpg and
greenscreen_overlay.png images. The user can then select the different backgrounds using the profile
shortcut keys. You can also switch green screen backgrounds and overlays by copying the new
greenscreen_background.jpg and greenscreen_overlay.png images into the photo booth images folder
while the booth is running.

Printing the Images
There are two methods to print out the green screened shots:
Method 1: PSRemote takes the photos, performs the green screen removal and prints the images.
PSRemote can perform simple green screen removal and print the images without the need for any
other software. This is simple to setup and is fine for small photobooth prints under good lighting
conditions. When green screen is enabled PSRemote will automatically replace the green background
with the background image when printing out the photobooth images unless the photobooth output
option is set to "None".
This method doesn't require any software other than PSRemote
Method 2: PSRemote takes the photos and saves them in a folder where another specialist green
screen application replaces the background and passes the images to Hotfolder Prints for formatting
and printing. This is more complicated to setup than method 1 but by using a specialist green screen
application it will give superior results which are more suitable for larger prints.
This method requires PSRemote v2.0 or later plus a green screen application such as Green Screen
Wizard Pro Batch and Hotfolder Prints.
When using method 2, green screen printing in PSRemote can be disabled by setting the output option
to "None" in the photobooth settings page. PSRemote will run the fullscreen photobooth complete with
green screened live view images and save the photos to the folder specified in preferences e.g. to
save the images in the folder C:\Photobooth the preferences should be set to:
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PSRemote preference settings to save the images in C:\Photobooth

The green screen app should be setup to monitor the folder where the photos are saved, automatically
replace the green background with the selected image and save them in a separate folder. The
settings for Green Screen Wizard Pro Batch to monitor photos in C:\Photobooth and save the green
screened images in C:\Photobooth\GreenScreen would be:
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Green Screen Wizard Pro Settings (click on Tools in the main window to display the settings)

Please see the Green Screen Wizard website for information about Green Screen Wizard Pro Batch
and to purchase a copy. Please make sure you purchase the Green Screen Wizard Pro Batch version
as this is the only version which can monitor a folder for new photos and automatically replace the
green background.
Important: To ensure that what the user sees in PSRemote's live view display and the final printed
output is the same the green screen background image should have an aspect ratio of 3:2. If a
different aspect ratio is used the alignment of the background image may be different in the live view
display and the green screened prints. If the images are to printed on 6"x4" paper at 300 dpi the
background image should be a JPEG which is 1800 pixels wide by 1200 pixels high.
The green screen application will have its own settings for optimizing the green screen removal and
will need to be setup separately. The settings used in PSRemote's live view display will only affect
what the user sees, not the final prints when using a separate app to perform the green screen
removal.
Hotfolder Prints should then be setup to monitor the folder where the green screened images are
saved so that it can automatically format and print them as required. The Hotfolder Prints preferences
screen to monitor C:\Photobooth\GreenScreen for four new images and then automatically format and
print them would be:

© 2016 Breeze Systems Ltd

92

9.10

PSRemote

How to create PNG images using Photoshop
Photoshop
First create a new image with a transparent background. Then create a mask by clicking on the "Add
layer mask" in the layers palette.
Next add the graphics such as text overlays and picture frames to the image layer and use the layer
mask to control the transparency. In the layer mask white represents opaque, black represents fully
transparent and values between white and black represent increasing transparency.
Save a copy of the image as a PSD file for future reference and then save the image as a PNG file
named overlay.png.
An existing PNG image containing trnasparency information in the alpha channel can be edited in
Photoshop by loading it into Photoshop. The layer mask containing the transparency information can
be recreated by selecting Layer->Layer Mask->From Transparency.

Photoshop Elements
First create a new image with a transparent background. Next add the graphics such as text overlays
and picture frames and use the opacity slider for the layers to control opacity. To get a simple fade
effect, you can also use the gradient tool. Once you’re happy with your image, save a copy as a PSD
file for future reference and then save the image as a PNG file named overlay.png.
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Uploading to social networking and photo sharing sites
Uploading photos to the user's personal Facebook page
Users can upload photos to their personal Facebook page directly from the photo booth if it has an
internet connection and either a touchscreen or a keyboard to enter their Facebook login information.
The simplest way to set this up is to use the photobooth setup wizard and then adjust the settings if
required. After running the photobooth setup wizard the Facebook settings can editing using the dialog
below. This dialog can be opened by opening the "Photobooth Settings" dialog (File->Photobooth
Settings... or Ctrl+S) then opening the "Output Settings" dialog clicking on the "Settings..." button to the
right of the output options and then clicking on the Facebook upload "Settings..." button.

The album name setting specifies the name of the album that will be created on the user's Facebook
page. Tokens for the date and time can be included in album name and will be replaced with the date
or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday, June
08, 2015
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, June 08, 2015 20:23:56
Please see the tokens section for a list of available tokens.
Please note: It is no longer possible to specify the album or photo description when uploading photos
to Facebook. This option was removed in DSLR Remote Pro for Windows v3.3 to comply with current
Facebook policy: Facebook Platform Policy 2.3. This states that an app can only populate the user
message with content manually entered by the user. The user can enter a message by using the
keyboard.xml file to add prompt3 when the touchscreen keyboard is asking the user to their Facebook
username (prompt1) and password (prompt2). Only the text entered by the user will be used for the
photo description. Please see the "Touchscreen Keyboard" section for information on customizing the
touchscreen keyboard.
The photo that is uploaded to the user's Facebook page is based on the JPEG copy of the printed
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output. You can crop, resize and rotate the image before uploading it to Facebook.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top
offset in pixels for the top left corner of the cropped image. Then specify the width and height of the
image in pixels. For example if the photobooth is setup to print a double strip of 4 images on 6"x4"
paper you may wish to crop the image uploaded to Facebook so that only a single strip is sent. If the
printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles
high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and
height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is uploaded to Facebook. Keeping these values relatively small, e.
g. 500 x 500 pixels, will reduce the time it takes to upload the file.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the the "Photobooth Settings"
dialog) this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being uploaded to
Facebook.
Select the "Log uploads to file:" checkbox to log Facebook uploads to a CSV file. Then either type in
the filename of the log file in the editbox or click on the "..." to open a file browser. The log file contains
a line for each Facebook upload attempt containing the following comma separated values: the date in
the format YYYYMMDD, the time in the format HHMMSS, the Facebook username prefixed with
FACEBOOK_USERNAME: and with @ characters replaced by _ , the status (1=success, 0=failure)
and the filename of the image file e.g.
20140114,174842,FACEBOOK_USERNAME:test_gmail.com,1,C:
\Users\Chris\Documents\PhotoboothImages\2014-01-14\prints\140114_174826.jpg
Please note: The log file only contains the date/time, username, filename and whether the upload was
successful. The user's password is NOT recorded and therefore the log file cannot be used to upload
photos to Facebook after the event.
In Operation
When the photobooth is run and the photos have been taken the print preview screen will be displayed
first (if "Confirm before printing" is selected) and then when the user selects "Print" the sharing screen
(share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the sharing screen
won't be displayed and the booth will return to the ready screen (ready.jpg). If the "Confirm before
printing" option is not selected the sharing screen will be displayed after taking the photos.
When the sharing screen (share.jpg) the user has the option to upload the photo to Facebook by
touching the Facebook button on the touchscreen or by typing F if they are using a normal keyboard.
The sharing screen can be exited by touching the "Cancel" button on the touchscreen or by typing X or
Esc on a normal keyboard. The sharing screen will also exit automatically if the user does nothing and
the screen timeout occurs. The sharing screen timeout can be specified in the "Output Settings"
dialog.
When the user selects Facebook upload the touchscreen keyboard will be displayed allowing them to
enter their Facebook user name and password. The user can enter their user name and password by
tapping on the touchscreen keyboard or by typing them in using a normal keyboard. The user can then
either tap on the "Cancel" button (or type Esc) to cancel the upload or tap on the "Upload photo" button
(or press the keyboard Enter key) to start the upload. The touchscreen keyboard will cancel
automatically if the user doesn't tap the touchscreen or type anything and the keyboard timeout occurs.
The keyboard timeout can be specified in the "Touchscreen Settings" dialog which can be displayed
from the "Photobooth Settings" dialog.
When the user has entered their Facebook user name and password and selected "Upload photo" the
Facebook login screen (fb_login.jpg) will be displayed together with a small web browser window

© 2016 Breeze Systems Ltd

Photobooth Shooting

95

showing the Facebook login page. The user must tap the "Ok" button or press the Enter key on the
keyboard to login to Facebook. If this is the first time the user has uploaded a photo they will need to
authorize the PhotoBoothUploader app by tapping the "Ok" button (or pressing the Enter key on the
keyboard) when the next two Facebook screens are displayed. If the user decides not to authorize the
PhotoBoothUploader app by tapping the "Cancel" button the upload will be aborted and the login
failure screen (fb_login_failure.jpg) will be displayed for a few seconds and then the screen will return
to the sharing screen.
After the user has logged in and authorized the PhotoBoothUploader app the upload will start and the
Facebook upload screen (fb_upload.jpg) will be displayed. If the upload is successful the Facebook
success screen (fb_success.jpg) will be displayed for a few seconds and then the screen will return to
the sharing screen. If there is an error (e.g. the internet connection was lost) the Facebook error
screen (fb_error.jpg) will be displayed for a few seconds and then the screen will return to the sharing
screen.
If there is a timeout waiting for the user to login and authorize the PhotoBoothUploader app the upload
will be aborted and the timeout screen (fb_timeout.jpg) will be displayed for a few seconds and then
the screen will return to the sharing screen.
The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.
If you have problems with the Windows Taskbar appearing when uploading photos to Facebook you
can run the HideWindowsTaskbar.exe utility to hide the Windows taskbar. HideWindowsTaskbar.exe
will automatically hide the Windows taskbar when PSRemote is running in full screen photobooth
mode. HideWindowsTaskbar.exe can be found in the PSRemote installation folder (usually C:
\Program Files (x86)\BreezeSys\ PSRemote on 64-bit Windows).
Please note: The user's Facebook username and password are private and are not saved by the
photobooth software.

Emailing photos
Users can email photos directly from the photo booth if it has an internet connection and either a
touchscreen or a keyboard to enter their email address. The simplest way to set this up is to use the
photobooth setup wizard and then adjust the settings if required. After running the photobooth setup
wizard the email settings can editing using the dialog below. This dialog can be opened by opening the
"Photobooth Settings" dialog (File->Photobooth Settings... or Ctrl+S) then opening the "Output
Settings" dialog clicking on the "Settings..." button to the right of the output options and then clicking on
the email photo "Settings..." button.
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The "Subject:" text box defines the text in the subject line of the email.
The body text of the message can be specified in plain text or in HTML format to provide more control
over its appearance. When using the HTML format the token {image} represents the URL of the photo
to be emailed and can be used with HTML <img> tag e.g. <img src="{image}">.
Tokens for the date and time can be included in the email subject and message text fields and will be
replaced with the date or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday,
January 08, 2014
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, January 08, 2014 20:23:56
{sharingMessage} is replaced with contents of the second text entry field (if defined) in the
touchscreen keyboard used for entering the user's email address. This allows the user to enter an
optional message when emailing photos.
Please see the tokens section for a list of available tokens.
The photo that is emailed is based on the JPEG copy of the printed output. You can crop, resize and
rotate the image before it is emailed to the user.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top
offset in pixels for the top left corner of the cropped image. Then specify the width and height of the
image in pixels. For example if the photobooth is setup to print a double strip of 4 images on 6"x4"
paper you may wish to crop the image so that only a single strip is emailed to the user. If the printer is
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set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles high (6" x
300 DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to send the email.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the the "Photobooth Settings"
dialog) this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being emailed to the
user.
The email server settings also need to be setup so that the program can email the photos. The "Email
Server Settings" dialog can be opened by selecting "Email Server Settings..." from the File menu or by
clicking on the "Email server settings..." button in the "Output Settings" dialog. The "Email Server
Settings" dialog shown below will be displayed:
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To send an email you need to specify the host name and port number of your email server. Most email
servers also require a username and a password to prevent unauthorized users from sending spam
emails. For additional security select the "Use SSL for secure email" option to send the email using
SSL. The port number should normally be set to 587 when using SSL secure email or 25 otherwise
(please check the port numbers used by your ISP). Google's free GMail service is a convenient way to
send emails and can be set up using the settings shown above and replacing yourname@gmail.com
with your GMail email address and entering your password. Set the "Email addr:" to the sender's email
address. Most ISPs require the sender's email address to the be the same as that of the email account
specified by the username and password.
Please note: If you are using GMail to send emails you need to go to your Google account settings
and set the "Access for less secure apps" option to "Turn on" otherwise GMail will refuse to send the
email.
The settings can be verified by sending a test email by entering the destination email address and then
clicking on the "Send test email to:" button. The email status and any error messages will be displayed
in the status area at the bottom of the dialog.
Select the "Log email addresses to file:" checkbox to log the email addresses to a CSV file. Then
either type in the filename of the log file in the editbox or click on the "..." to open a file browser. The
log file contains a line for each email containing the following comma separated values: the date in the
format YYYYMMDD, the time in the format HHMMSS, the email address, the status (1=success,
0=failure) and the filename of the image file e.g.
20140114,174842,test@gmail.com,1,C:\Users\Chris\Documents\PhotoboothImages\2014-01-14
\prints\140114_174826.jpg
In Operation
When the photobooth is run and the photos have been taken the print preview screen will be displayed
first (if "Confirm before printing" is selected) and then when the user selects "Print" the sharing screen
(share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the sharing screen
won't be displayed and the booth will return to the ready screen (ready.jpg). If the "Confirm before
printing" option is not selected the sharing screen will be displayed after taking the photos.
When the sharing screen (share.jpg) the user has the option to email the photo by touching the email
button on the touchscreen or by typing E if they are using a normal keyboard. The sharing screen can
be exited by touching the "Cancel" button on the touchscreen or by typing X or Esc on a normal
keyboard. The sharing screen will also exit automatically if the user does nothing and the screen
timeout occurs. The sharing screen timeout can be specified in the "Output Settings" dialog.
When the user selects email photo the touchscreen keyboard will be displayed allowing them to enter
the email address. The user can enter the email address by tapping on the touchscreen keyboard or
by typing it in using a normal keyboard. The user can then either tap on the "Cancel" button (or type
Esc) to cancel the email or tap on the "Send email" button (or press the keyboard Enter key) to start
the upload. The touchscreen keyboard will cancel automatically if the user doesn't tap the touchscreen
or type anything and the keyboard timeout occurs. The keyboard timeout can be specified in the
"Touchscreen Settings" dialog which can be displayed from the "Photobooth Settings" dialog.
When the user has entered their email address and selected "Send email" the email upload screen
(email_photo.jpg) will be displayed and the photo will be emailed. If the email is successful the email
success screen (email_success.jpg) will be displayed for a few seconds and then the screen will return
to the sharing screen. If there is an error (e.g. the internet connection was lost) the email error screen
(email_error.jpg) will be displayed together with an error message in the bottom right hand corner.
After a few seconds the screen will return to the sharing screen.
The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.
Email "Offline Mode" and sending emails after an event

© 2016 Breeze Systems Ltd

Photobooth Shooting

99

If no internet connection is available at an event you can save user's email addresses and send the
emails later when an internet connection is available. To do this you need to enable "Email photo" in
the "Sharing" section of the "Output Settings" dialog and also select the "Offline mode" option. You
also need to select the "Log email addresses to file" in the "Email Server Settings" dialog - this will
save the user's email address together with the filename of their photos.
The emails can be sent when an internet connection is available by selecting "Send emails..." from the
"File" menu in the main window. When you select this you will be asked the log file to read (this
defaults to the email log file specified in the "Email Server Settings"). The "Unsent Emails" dialog will
be displayed listing the date/time, email address and photo for unsent emails found in the log file.
Select the emails you wish to send and then press the "Send" button to send them.
Please note: There is no offline option for Facebook uploads because users need to enter both their
username and password to allow uploading to their Facebook account and no system should ever
keep a record of users' passwords.

Notes on using a normal keyboard for Facebook uploads and
emailing photos
The Facebook upload and email photo options are designed to be used with a touchscreen, but can
also be operated using a normal keyboard. Please note that if you give users access to a keyboard
you need to prevent them from causing problems by exiting out of the photobooth program (e.g. by
typing Ctrl+Alt+Delete, Ctrl+tab or pressing the Windows key). One way to do this is to take a basic
USB keyboard and either wedge or glue the Ctrl, Alt, Win etc. keys so that they can't be pressed.
The following keys can be used to navigate the print preview, sharing and Facebook login screens:
Print preview:
Type A to print the photos
Type X or Esc to cancel printing
Sharing screen:
Type F to upload to Facebook
Type E to upload to email the photos
Type X or Esc to exit the sharing screen and return to the ready screen
Touchscreen keyboard:
Type in the user name and password using the normal keyboard keys
Type Tab to switch between the username and password input
Type Enter to start logging in to Facebook after entering the username and password
Type Esc to exit and return to the sharing screen
Facebook login and PhotoBoothUploader app authorization screens:
Type Enter to login to Facebook and Enter again to authorize the PhotoBoothUploader app

Uploading photos to your personal or business Facebook page
There are a number of free tools for automatically uploading photos to your personal or business
Facebook page or to other social networking or photo sharing sites:
1. Dropbox - Dropbox is a free service for synchronizing files across multiple computers and devices.
When a file is copied into the Dropbox folder on your computer it is automatically uploaded to online
storage in the Cloud. If a photo is copied to a subfolder in the Photos Dropbox folder it will
automatically create an online gallery which can be viewed using a web browser.
Dropbox comes with 2 GB of free online storage which can be increased for a monthly fee. Please
visit the Dropbox website for more details.
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2. IFTTT + Dropbox/Box/Google Drive- IFFT (If This Then That) is a free web based automation tool
that works in conjunction with free online storage services such as Dropbox, Box and Google Drive.
It uses "recipes" to perform actions when files are added to your online storage. It can link to many
services including Facebook (to access your personal Facebook page), Facebook pages (to access
a business Facebook page), Flickr, YouTube and Twitter. The recipes are run every 15 minutes and
can upload a maximum of 15 photos each update.
Please visit the IFTTT website for more details
3. Wappwolf + Dropbox/Box/Google Drive - Wappwolf offers a similar service to IFFT and can also
to many services including Facebook (to access your personal Facebook page), Facebook pages
(to access a business Facebook page), Flickr, Picassa/Google+ Upload, YouTube and Twitter.
Please visit the Wappwolf website for more details
All of the above services work by monitoring a folder on you PC and automatically uploading the
photos to the Cloud or directly to a Facebook album. The output options in PSRemote can be used to
automatically crop and resize the prints from the photobooth and copy the image to the folder being
monitored for uploading to the Cloud and/or Facebook. The output settings dialog can be displayed by
setting the output option in the photobooth settings to "Print and save JPEG copy" or "JPEG copy only"
and pressing the "Settings..." button:
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Select the "Copy JPEG to folder:" option and enter the name of the folder where the JPEG copy of the
printed output should be copied to. This should be the folder that is being monitored by your the online
storage service. The JPEG copy of the printed output is formatted for sending to a printer and may be
larger than you want for uploading to Facebook. For example a typical double strip of 4 images printed
at 300 DPI on 4"x6" paper will be 1200 x 1800 pixels in size and will show two strips of 4 photos side
by side. You may want to limit the size for faster uploading and viewing on guests' cell phones etc. and
to crop the image so that it only shows a single strip of 4 photos. You can do this using the "Crop
image before copying" and "Resize image before copying" options as shown below:
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If you need more control over the layout...
Please take a look at our Hotfolder Prints software if you need more control over how the photos are
formatted before being uploaded to Facebook and other social networking sites. Hotfolder Prints
allows you to create a completely new layout optimized for uploading (e.g. formatting on a 452x440
pixel page to look great in Facebook's timeline) and to add logos or other information that doesn't
appear in the printed strips. Hotfolder Prints can also email photos to users (using the email address
entered using the touchscreen keyboard) and run a slideshow which is automatically updated as new
photos are taken.

Online Storage Services
The free IFTTT and Wapwolf web automation tools can be used in conjunction with the following free
Cloud based online storage services:
· Dropbox: 2 GB of free online storage, more available for a monthly fee
· Box: 5 GB of free online storage, more available for a monthly fee
· Google Drive: 5 GB of free online storage, more available for a monthly fee
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Please note the information above was correct at the time of writing but may have changed since.
Please check the relevant websites for the latest information about the various services described on
this page.

10

Preferences
Click on "File->Preferences" to display the preferences dialog.

Mouse Button Actions
The middle and right mouse buttons can be assigned to release the shutter or take pictures in
preview mode. This allows you to use the mouse like a simple cable release. The mouse
wheel can also be assigned to zoom the lens or adjust the shutter or aperture settings when
using Tv, Av or Manual exposure modes (when using Manual exposure hold the Ctrl key
down to adjust the aperture with the mouse wheel).
Note: This only works if the mouse pointer is over the main window and is not over one of
the controls.
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Preview Image Size
This allows the size of the JPEG image used in preview mode to be specified. The smallest
size gives the least detail but the fastest download and screen update. The largest size gives
more detail but takes longer to download.

Image Settings
Some cameras (e.g. PowerShot G2, S30 and S40) allow the setting of the image contrast,
sharpness and saturation. Use the controls in preferences to set the desired image parameters.
These controls will be disabled if the camera does not support this.

Specifying the output directory
These settings control where images are stored on the computer's hard disk. The edit box
displays the base directory for images and can be changed by typing directly into the edit box
or by clicking on the "..." button and using the directory browser. If the Year, Month and Day
checkboxes are not checked this will be the directory in which all images are stored.
Note: If the directory does not already exist it will be created when the photo is saved.
The Year, Month and Day checkbox control the automatic generation of subdirectories
according to the computer's date. The example image name shown at the bottom of the dialog
shows how the various settings are combined. Select the "Flatten date" checkbox to combine
the year, month and day into a single subdirectory e.g. in the example above:
July 21, 2003 with "Flatten date" unchecked gives "C:\10DRemote\2003\07\21"
"Flatten date" checked it gives "C:\10DRemote\2003-07-27"

Image Filenames
JPEG images are saved as 0001.JPG, 0002.JPG, 0003.JPG...
Raw images are saved as two files: the CRW file containing the raw image data and the THM
file containing a small JPEG thumbnail image. Raw images are saved as: 0001.CRW and
0001.THM, 0002.CRW and 0002.THM, 0003.CRW and 0003.THM...
You can specify an optional prefix to be added at the start of each image's filename e.g. the
prefix "studio shoot " would result filenames like "studio shoot 0001.JPG", "studio shoot
0002.CRW" etc.
The comment string entered in the main widow can also be prefixed to the filename. This can
be useful to identify sets of shots when taking a series of product shots of different products.
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You can also use tokens in the filename prefix and the directory name e.g. setting the
filename prefix to %d-%t- would give 100604-143256-0001.JPG for a photo taken at
14:32:56 on June 4th, 2010.
When "Append sequence letter to end of filename when auto-bracketing" is selected all the
images in the sequence will have the same filename with a letter indicating which image it is
in the sequence appended.
e.g. a 5 shot sequence would have filenames like:
prefix0002a.JPG, prefix0002b.JPG, prefix0002c.JPG, prefix0002d.JPG, prefix0002e.JPG
as opposed to:
prefix0002.JPG, prefix0003.JPG, prefix0004.JPG, prefix0005.JPG, prefix0006.JPG

11

Tokens
The following tokens read information from the shooting data of the images and are available for using
in the filenames of downloaded images and in the photobooth caption text.

Date and time tokens
%a

Abbreviated weekday name

e.g. Fri

%A

Full weekday name

e.g. Friday

%b

Abbreviated month name

e.g. Jun

%B

Full month name

e.g. June

%d

Date in the form YYMMDD (equivalent to %y%m
%D)

e.g. 030611 for June
11, 2010

%D

Day of the month (01 to 31)

%H

Hour (00 to 23)

%I

Hour (01 to 12)

%j

Day of the year (001 to 366)

%l

Long date/time representation of locale

e.g. Wednesday, June
17, 2010 19:03:47

%L

Long date representation for locale

e.g. Wednesday, June
17, 2010

%m

Month (01 to 12)

e.g. 06 for June

%M

Minutes (00 to 59)

%p

am/pm indicator

%S

Seconds (00 to 59)

%t

Time in the form HHMMSS (equivalent to %H%M
%S)

%W

Week number (00 to 53)

%x

Date representation for locale

e.g. 06_11_10 for June
11, 2010

%X

Time representation for locale

e.g. 14_39_29

%y

Year without century

e.g. 10
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%Y

Year with century

e.g. 2010

%z

Time zone name

e.g. GMT Standard
Time

%Z

Time zone offset wrt UTC

e.g. +0100 for GMT
during DST

{yearNow}

Year 'now' in the form YYYY

e.g. 2010

{monthNow}

Month 'now' (01 to 12)

{dayNow}

Day 'now' (01 to 31)

{yearLess8h}

Year with century 8 hours ago - useful when
shooting events which continue after midnight

{monthLess8h}

Month (01-12) 8 hours ago - useful when
shooting events which continue after midnight

{dayLess8h}

Day (01-31) 8 hours ago - useful when shooting
events which continue after midnight

Shooting data tokens
e.g. JPG for IMG_4567.
JPG

%e

File extension (without the '.')

%i

ISO value read from the shooting data

%o

Image filename without extension

%O

Owner string

{orientation}

Image orientation: L for landscape or P for
portrait

{orientationAngle}

Image orientation in degrees: 0, 90 or 270

e.g. IMG_4567

Tokens for modifying strings
The tokens below can be used to modify tokens or strings:
Token
{left,n,str}
{mid,n,m,str}

{right,n,str}

Description
Extracts the first n characters from str
(which can be a string or token).
Extracts m characters starting from the n'th
character from str (which can be a string or
token).
Extracts the last n characters from str
(which can be a string or token).

Example
{left,4,{filename}} for filename
IMG_1234.jpg would give IMG_
{mid,5,4,{filename}} for filename
IMG_1234.jpg would give 1234
{right,3,{filename}} for filename
IMG_1234.jpg would give .jpg

Other tokens
{comment}

The value of comment entered in the main
window

{photoboothNumImages Number of shots defined in photobooth mode

e.g. 4
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}
{photoboothImage}

Shot number in photobooth shooting sequence

e.g. first photo returns 1

{photoboothDateTime}

Date and time at the start of the current
photobooth shooting sequence

e.g. 20110126_190509

{photoboothDate}

Date at the start of the current photobooth
shooting sequence

e.g. Jan 26, 2011
returns 20110126

{photoboothTime}

Time at the start of the current photobooth
shooting sequence

e.g. 7:05:09 pm returns
190509

{photoboothDir}

The value of the full pathname of the photobooth
images folder

e.g. C:
\Photobooth\Profile1

{photoboothSubdir}

The value of the photobooth images subfolder

e.g. C:
\Photobooth\Profile1
gives Profile1

{photo1}, {photo2} etc.

Filename (without file extension or directory path)
of each photo in photobooth mode

{filename}

Filename of the saved print layout in photobooth
mode (only available for captions used in
photobooth prints)

{uid}

Unique id in the form ABC12345 updated at the
start of each photobooth shooting sequence. Can
be used in captions and the filename prefix. The
id is guaranteed not to repeat within 72 hours and
is very unlikely to repeat within 10 years.

[****]
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Sample Timings
The table below shows sample timings for the minimum interval between photographs when
triggering the shutter from the PC. The timings are to the nearest second using a Canon
PowerShot G5 with normal AF (not AF lock) and are for guidance only.
Size/Quality

Save to PC only

Save to camera only

Raw

33

8

Save to PC and
camera
24

Large/fine

15

5

10

Medium1/fine

9

4

6

Medium2/fine

6

4

5

Small/normal

4

3

4

The table below shows sample timings using a Canon PowerShot A70 with normal AF (not
AF lock).
Size/Quality
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Save to PC only

Save to camera only

Save to PC and
camera
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Raw

N/A

N/A

N/A

Large/fine

11

4

8

Medium1/fine

8

4

6

Medium2/fine

5

4

5

Small/normal

4

3

4

When the camera is operated in remote mode each picture has to be downloaded before the
next picture can be taken. This means the maximum frame rate is determined by the AF/AE
delay plus the time to take the picture plus the time to download the picture. The time to
download the picture depends on the size of the image file (which is determined by the image
size and quality settings and the amount of detail in the scene) and the speed of the USB
interface. The speed of the USB interface varies from camera model to camera model and is
usually between 0.3Mb/sec and 0.6Mb/sec.

Canon PowerShot S2 IS, S3 IS, S5 IS, S80, A620, A640,
SX100 IS, G7, G9 and G10
These cameras have a USB 2.0 interface and can download images much faster than other
PowerShot cameras which only have USB 1.1 interfaces.
The table below shows sample timings using a Canon PowerShot S3 IS with normal AF (not
AF lock). The timings for other USB 2.0 equipped cameras are similar.
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Size/Quality

Save to PC only

Save to camera only

Raw

N/A

N/A

Save to PC and
camera
N/A

Large/fine

2

2

3

Medium1/fine

2

2

2

Medium2/fine

2

2

2

Small/normal

2

2

2

Release Notes
21 December 2016: v3.3
· Added support for creating animated GIFs (and MP4 movie copies) in photo booth mode
· Added support for sending photos and animated GIFs by MMS (US and Canada only) or SMS via
Twilio.com
· Added support for sharing photos and animated GIFs via Twitter
· Added options to share animated GIFs by email and Facebook (animated GIFs shared on Facebook
are hosted on giphy.com)
· Added print option to sharing screen
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· Movie file display no longer uses Apple's QuickTime libraries
15 December 2015: v3.2.2
· Fixed a problem with image attachments not displaying in emails sent to Outlook.com
· Replaced %1, %2, %3, %4, %5, %6 tokens with {yearNow}, {monthNow}, {dayNow}, {yearLess8h},
{monthLess8h}, {dayLess8h} to avoid problems with unwanted substitutions in emails
· Fixed a typo in the default text for HTML emails: correcting <image src="{image}"> to <img
src="{image}">
9 November 2015: v3.2.1
· Fixes a problem in PSRemote v3.2 with setting the print preview size and position in the print
confirmation screen
19 October 2015: v3.2
· Added new touchscreen action editor
· Added "Message input at end of sequence" touchscreen keyboard option to allow users to enter a
message which can be added to the printed output (using the {message} token)
· Added an option to print photos from the sharing screen (this can also be selected when running the
photobooth setup wizard)
· Added optional password to protect "exit photobooth mode" touchscreen action
· Added touchscreen actions and keyboard shortcuts to select a profile and start the shooting
sequence (profiles 1 to 8 only)
· Added the option to log Facebook uploads to file
· The default touchscreen keyboard for entering the user's Facebook login name and password now
displays punctuation characters when the shift key is pressed (US keyboard layout)
· Email message text can now be specified in HTML format and plain text format
· Added offline email mode and the ability to send the emails after the event
· Added mandatory option to <prompt> tag in touchscreen keyboard XML definition to indicate that an
input field must contain text
· Added Inactivity timer which automatically switches the photo booth to standby mode after a user
definable period of inactivity
· Now supports up to 12 captions in the print layout, options to change the caption display order and
the option to right justify the caption text
9 October 2014: v3.1
· Added the option to crop the photo before uploading to Facebook or sending by email
· Added "Single strip of 2" preset layout option
· Fixed a possible problem where uninstalling a printer driver could cause the program to crash
· The body text for emails now allows return characters
· Improved error reporting when testing and sending emails and improved support for services such
as free email services like yahoo.com
25 August 2014: v3.0.1
· Fixed a problem which caused version 3.0 to crash on some systems
5 August 2014: v3.0
· Added interactive editor for photobooth print layouts
· Added the importing and exporting of photobooth print layouts
· Added the ability to print QR codes on photobooth prints
· Added optional thumbnail display in photobooth mode
· Added new photobooth dashboard to provide quick access to the main photobooth settings
· Added 3:2 aspect ratio option for compatibility with DSLR photobooth templates
· Increased the number of photobooth profiles from 8 to 18
· Increased the number of photobooth captions from 2 to 8
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20 February 2014: v2.6
· Added the ability to upload photos to a user's Facebook page in photobooth mode
· Added the ability to email photos in photobooth mode
· Added "Confirm printing (no JPEG copy)" print option in photobooth mode
· Added the option to rotate as well as crop and resize the additional JPEG copy of the printed output
· Added a single photo layout option in the photobooth setup wizard and preset layouts tool
· Improved the performance of printing custom layouts in photobooth mode when images are printed
multiple times e.g. the double strip of four layout
· Now disables touchscreen edge gestures when running in full screen photobooth mode on Windows
8 and Windows 8.1 systems
· Fixed a problem with the final photo preview being dismissed too quickly in photobooth mode
· Fixed a problem the ready screen not being updated when using touchscreen actions to switch
between color and B&W in photobooth mode
8 February 2013: v2.5.1
· Fixed a problem with cropping and resizing the JPEG copy of the printed output in photobooth mode
· Fixed a problem with using the {photoboothDir} and {photoboothSubdir} tokens with profiles in
photobooth mode
27 November 2012: v2.5
· Added the ability to use movies to animate photobooth screens
· Added next/previous profile keyboard shortcuts and touchscreen actions in photobooth mode
· Fixed a problem with screen updates when switching from a photobooth profile with live view
enabled to one with it disabled
· Added two new preset photobooth layouts: double strip of 3 photos and single strip of 3 photos
8 November 2012: v2.4
· Added post processing options in photo booth mode for easier website and social networking site
uploads
· Added fast resize option in photobooth mode - provides faster print processing with minimal
reduction in image quality
· Added options to reprint photo booth photos after an event
16 May 2012: v2.3
· Added Photobooth Setup Wizard which automatically creates all the screens and the print layout for
common photobooth configurations
· Added an option to include the current printer settings when saving the photobooth settings to file
· Added a quick reprint option (keyboard shortcut: Ctrl+Shift+R) when the output option is set to "Print
and save JPEG copy"
· Added {uid} token which generates a unique id for filenames and captions when shooting in
photobooth mode
3 February 2012: v2.2.2
· Added <caption1> and <caption2> tags to the XML photobooth summary file
· Added an option to the touchscreen keyboard to hide text when entering a password
· Greenscreen backgrounds can now be replaced by copying the new greenscreen_background.jpg
image into the photo booth images folder while the booth is running
· Fixed problems using 8 profiles in photobooth mode
PSRemote v2.2.1, released 11 January 2012
· Added timeouts in photobooth mode for print confirmation and touchscreen keyboard input
· Displays optional reprinting,jpg screen image and skips the print confirmation screen when reprinting
photobooth images
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· Added optional checkboxes to the touchscreen keyboard in photobooth mode
PSRemote v2.2, released 8 November 2011
· Fixed a problem with photobooth preview images not showing the virtual background when green
screen shooting
· Added the ability to specify a horizontal offset for the live view display in photobooth mode
· Added the option to use {photoboothSubDir} or {photoboothDir} tokens when specifying the profile
pathname to allow the use of more than 8 photobooth profiles
· Added a separate delay for the first photo in the stills photobooth shooting sequence
· Added optional color management of printed images
· Fixed a problem with incomplete screen refreshes when switching photobooth profiles
PSRemote v2.1.2, released 3 August 2011
· Added preset layouts when using the custom layout option to help design popular layouts using four
photos
· Added monochrome tint option to support printing in sepia and other tints in photobooth mode
· Added standby option in photobooth mode
PSRemote v2.1.1, released 4 May 2011
· Added blue screen shooting
· Added default profile option to reset the photobooth to a known state after each shooting sequence
· Enhanced touchscreen keyboard in photobooth mode to allow multiple input fields and the use of a
normal keyboard
PSRemote v2.1, released 8 February 2011
1. Added confirm_printing.jpg and printing_confirmed.jpg screens when using the print confirmation
option in photo booth mode
2. Added optional touchscreen keyboard in photo booth mode
3. Green screen shooting in full screen photo booth mode now has the ability to use different
backgrounds and overlays for each shot and to save a green screened copy of each photo
PSRemote v2.0, released 10 November 2010
1. Added green screen shooting in photobooth mode
2. Added the ability to crop live view images in fullscreen photobooth mode by holding down the shift
key and using the cursor left/right keys
3. Photobooth mode now has the options to specify the vertical positioning of the countdown text and
to disable live view during printing
4. Fixed a problem with dark live view images when using a Canon PowerShot G9 or G10 with the
manual exposure setting and flash in full screen photobooth mode
5. Fixed a problem saving and restoring the aperture value when using a Canon PowerShot S5 IS
PSRemote v1.9.1, released 26 May 2010
1. Fixed a problem that caused the error message "An Invalid Argument Was Encountered" to be
displayed on some systems when selecting full screen photobooth mode
PSRemote v1.9, released 24 May 2010
Added the following enhancements to photobooth shooting:
· New, more flexible custom layout of prints including image rotation. Please note that custom layouts
from previous versions of PSRemote will need to be updated if they use the "Copy left half of page
to right to create a double strip" option
· Captions can now be rotated
· Live view is hidden when displaying the release.jpg image to avoid confusion caused by the live view
freezing just before the picture is taken
· Added an optional minimum duration before closing the processing.jpg screen to allow a 'Please
leave the booth now' message to be displayed for several seconds at the end of the sequence
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· Improved handling of external button presses in photobooth mode to prevent a new shooting
sequence from being started before the current one has finished printing
PSRemote v1.8.2.1, released 15 March 2010
1. Added MinZoomSetting and MaxZoomSetting registry settings for limiting the lens zoom range
2. Now updates the screen image in fullscreen photobooth mode when switching between B&W and
color
PSRemote v1.8.2, released 11 February 2010
1. Photobooth countdown next now centered above the live view images when the live view images
are placed towards the bottom of the screen
2. Added touchscreen options for zooming the lens and reprints
PSRemote v1.8.1, released 2 January 2010
1. Added checks during photobooth printing to prevent users pressing buttons from causing printing to
switch between B&W and color
2. Fixed a problem reading registration codes issued after 2009
PSRemote v1.8, released 24 November 2009
1. Added more flexible touchscreen options to photobooth mode and the ability to switch between
different sets of photobooth settings
2. A camera delay can now be entered in the photobooth settings to allow for older PowerShot models
which may have a significant delay when taking photos
3. Added optional release.jpg screen which is displayed immediately before taking a picture in full
screen photobooth mode
4. Added Ctrl+R keyboard shortcut in full screen photobooth mode to reprint the last print
PSRemote v1.7, released 5 August 2009
1. Added custom layout option for photobooth prints and the ability to load and save photobooth
settings
2. Fixed occasional problem on some PCs which resulted in 'back to back' shots in photobooth mode
where the next shot is taken immediately after the last shot has been downloaded
3. The photobooth input option to "Left click top left to start color sequence, bottom left for B&W" now
works properly when clicking in the bottom left of the screen.
4. Fixed a problem with the white balance settings when using older PowerShot models
PSRemote v1.6.5, released 11 March 2009
1. Fullscreen photobooth shooting now includes an option to use the mouse for triggering the
photobooth sequence and for switching between B&W or color photos
2. Added auto-reconnect option in photobooth mode
3. Added the ability to play .wav sound files when displaying photobooth prompt screens
4. Added the ability to specify the number of copies of photobooth prints
5. Added additional start options for fullscreen photobooth mode to facilitate the use of touchscreens
6. Added support for the StealthSwitch in fullscreen photobooth mode
PSRemote v1.6.4, released 16 October 2008
1. Added left.jpg, right.jpg and middle.jpg options for more flexible layout of images in photobooth
mode
1. Added information about how to use external buttons for photobooth shooting
2. Added an "offset from top option" to the photobooth settings to give more flexibility in the positioning
of the live viewfinder
3. Added support for Canon PowerShot SX110 IS and Canon PowerShot G10
PSRemote v1.6.3, released 24 July 2008
1. Added option to show or hide the progress bar when processing images in photobooth mode
2. Added optional cropping of JPEG images
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PSRemote v1.6.2, released 5 June 2008
1. Added preview display, countdown font size and color selection, caption printing and print only/print
and save image or save image only options in photobooth mode
2. Optimized live viewfinder display to make it less CPU intensive
3. Now supports custom white balance with recent cameras
4. Added workaround for Canon PowerShot G9 bug where focus is lost when taking pictures using
close-up AF
PSRemote v1.6.1, released 9 May 2008
1. Added GDIplus.dll required for running on Windows 2000
2. Added F2 and F3 keyboard shortcuts for taking photobooth shots in B&W or color respectively
PSRemote v1.6, released 24 April 2008
1. Added photobooth shooting mode
2. Added lossless JPEG auto rotation option
PSRemote v1.5.8, released 11 January 2008
1. Added support for Windows Vista
PSRemote v1.5.7, released 26 October 2007
1. Added support for Canon PowerShot SX100 IS
PSRemote v1.5.6, released 19 September 2007
1. Added preliminary support for Canon PowerShot G9 - fully supports the camera apart from shooting
in raw mode
PSRemote v1.5.5, released 22 August 2007
1. Added support for Canon PowerShot S5 IS
2. Added camera auto-reconnect option
PSRemote v1.5.4, released 18 April 2007
1. Added 2x, 3x, 4x and fill screen live viewfinder scaling
2. PSRemoteLib extended to give control over autofocus and live viewfinder
3. Displays lens focal length and zoom information for G7 and A640
PSRemote v1.5.3, released 14 November 2006
1. Added the option to run a batch command after completing an auto-bracket sequence
2. Extended the auto bracket shot separation to up to 2 stops separating each shot
3. Simplified the interface to motion detection software
PSRemote v1.5.2, released 30 June 2006
1. Added option for appending a sequence letter to the end of image filenames when shooting autobracket sequences
2. Fixed problems with Canon PowerShot A620, S80 and S3 IS on Windows 2000
PSRemote v1.5.1, released 26 April 2006
1. Improved support for the Canon PowerShot S3 IS
2. Improved control over zooming the lens when using the mouse to drag the slider
PSRemote v1.5, released 16 March 2006
1. Added JPEG post processing option to resize, auto level and sharpen the image
2. Added support for Canon PowerShot S2 IS, S80 and A620
3. Added preliminary support for Canon PowerShot S3 IS
4. Added new auto bracket feature
5. Added motion detection option (requires additional software)
6. Added the following functions to the interface library: connect/disconnect camera; set white balance;
exit PSRemote
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7. Included sample Perl script which uses the command line app for interval shooting with PSRemote
8. Added option to re-learn camera settings
PSRemote v1.4, released 18 January 2005
1. Improved "learning" of camera settings the first time it is connected
2. Additional checks for out of range Tv values when learning camera settings
3. Added new function call to set filename prefix when using the interface library
4. Added a section in the help file about using the interface library
PSRemote v1.3, released 8 July 2004
1. Added support for Canon PowerShot S1 IS
2. Improved support for Canon PowerShot Pro1
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